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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©September 2008

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.

Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
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FCC Statement

(Federal Communications Commission)

You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1.

This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This

equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.

\ A/
ZAS
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A (65 Watts)/18.5V, 3.5A (65 Watts) minimum AC/DC Adapter for Model A, B & E comput-
ers, OR 19V, 4.74A (90 Watts) minimum AC/DC Adapter for Model C, D & F computers.

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER,
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product




Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.
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Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

Do not place it on an unstable
surface.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

@

Do not leave it in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surface that will block the
Vents/Fan Intakes.
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Perform routine maintenance
on your computer.

Do not disassemble the com-
puter by yourself.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:

» Only use a power adapter approved for use with this computer.

» Your AC/DC adapter may be designed for international travel but it still requires a 7Il,<
steady, uninterrupted power supply. If you are unsure of your local power specifications, Power Safety
consult your service representative or local power company. Warning

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third Before you undertake
prong is an important safety feature; do not defeat its purpose. If you do not have access any upgrade proce-

to a compatible outlet, have a qualified electrician install one. dures, make sure that
you have turned off the

power, and discon-

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not
by its wire.

. nected all peripherals
» Make sure the socket and any extension cord(s) you use can support the total current e

and cables (including

load of all the connected devices. telephone lines). It is
» Before cleaning the computer, make sure it is disconnected from any external power advisable to also re-
supplies (i.e. AC/DC adapter or car adapter). move your battery in
order to prevent acci-
dentally turning the
Do not plug in the power Do not use the power cord if | Do not place heavy objects machine on.
cord if you are wet. it is broken. on the power cord.

\1
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Battery Precautions

« Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

« Do not remove any batteries from the computer while it is powered on.

« Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
A&
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

VI
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

« If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep itdry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

Xl
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

< Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.

¢ Use a chair with a back and adjust it to support your lower back comfortably.

« Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

e Take periodic breaks if you are using the computer for long periods of time.

Remember to:

e Alter your posture frequently.

»  Stretch and exercise your body several times a day.

»  Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

Xl
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system is not in use.

X1l
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.

e Chapter 3  The computer’s power saving options.

e Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 6  Instructions for upgrading your computer.

» Chapter 7 A quick guide to the computer’s Fingerprint, Bluetooth, Wireless LAN, PC Camera and 3.5G
modules (some of which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

« Appendix B Information on the SiS Video driver controls.

» Appendix C Information on the NVIDIA Video driver controls.

» Appendix D The computer’s specification.

» Appendix E Information on the Windows XP OS.
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a /Z of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark . remainder of the User’s Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
tors foatire. e <™ | may find it useful to refer to the notes marked with a #as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
Overview 1 -3
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Model Differences
This notebook series includes six different model types (each model includes different design styles) as indicated in

Table 1 - 1. The exact outward appearance and some of the Hot-Key buttons may appear slightly different from those
illustrated in this manual, however all the ports, components and functions etc. are the same for each design style.

Feature Model A Model B Model C Model D Model E Model F
. . . . . SiISM672 + SiS 671DX +
Core Logic SiS M672 + SiS968 SiS 671DX + SiS968 SiS968 SiS968

SiS Integrated Video System

NVIDIA Discrete Video System

SiS Integrated
Video System

NVIDIA Discrete
Video System

Video Adapter (Internal On Chip) (External On Board) (Internal On (External On
Chip) Board)
65W (DC Output
AC/DC 65W (DC Output 19V, 3.42A or 90W (DC Output
ey 185V, 3.5A) 90W (DC Output 19V, 4.74A) 119g/,5\3/.432/5\A(;r 19V, 4.747)
Display Type
Supported 14.1"LCD 15.4" LCD 14.1"LCD 15.4"LCD 17" TFTLCD | 17" TFTLCD
(see page D -
3 for details)
Fir&gerdprint Not Available Not Available Optional Optional Optional Optional
eader

Table 1 - 1 - Model Differences

1 -4 Overview
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System Startup

Remove all packing materials.

Place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

PobhPE

o

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu
in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In

System Startup 1-5
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Operating System Setup

If you are installing new system software, or are re-configuring your computer for a different system, make sure you
configure the appropriate OS setting in the BIOS before installing a new operating system (Note: If you have installed
the Windows Vista operating system with AHCI mode enabled, DO NOT disable AHCI mode or you will need to

reinstall the Windows Vista OS).

1. Start-up the computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select “Installed O/S” and make sure the appropriate operating system is selected.

3. Go to the Exit menu and select “Exit Saving Changes” (or press F10 and select “Yes” then press Enter) and
press Enter to exit the BIOS and reboot the computer.

PhoenixBIOS Setup Utility

m Advanced Security Boot Exit

Item Specific Help
visTay
SATA Mode Selection: [AHCI] .
Legacy USB Support: [Enabled] Sellewi .the operating
Boot-time Diagnostic Screen: [Enabled] syaleam lmssailicel .
Power on Boot Beep [Disabled] (e yo‘,lr system which
Battery Low Alarm Beep: [Disabled] et L S mershe
commonly .
. . . Note: An incorrect
Only available if Windgwsy ST
5 some operating
is selected as the OfS. | svsens co icpiay
unexpected behavior.
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

4

SATA Mode Selection

Make sure that you have selected the appro-
priate SATA Mode Selection for your hard
disk. If you have installed the Vista O/S with
AHCI or IDE mode selected, do not change
the setting (otherwise you will need to rein-
stall your O/S).

Figure 1 - 2 - Advanced BIOS Menu

1 - 6 Operating System Setup
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System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported.

Operating System & Version Note

In order to run Windows XP without limitations
or decreased performance, your computer
requires a minimum 512MB of system memory
(RAM)

*Windows XP (Home or Professional)

limitations or decreased performance, your
computer requires a minimum 1GB of system

Windows Vista - SP1 (32-bit/64-bit) Business/Enterprise/Ultimate Editions | memory (RAM).

Windows Vista - SP1 (32-bit/64-bit) Home Premium Edition

Table 1 - 2 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-
dows XP Information” on page E - 1.

4

Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which includes Service Pack 1) before installing
any drivers. Go to the Microsoft website for download details, or contact your service center.

Operating System Setup 1-7
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System Map: LCD Panel Open - Models A & C

Figure1-3
LCD Panel Open sa
(Model A & C 2L
Computers) Wireless Device

Operation Aboard Aircraft

1. Built-In PC Camera
(Optional) The use of any portable electronic trans-
2. LCD mission devices aboard aircraft is usually
3. Speakers prohibited. Make sure the module(s) are
OFF if you are using the computer aboard
4. Power Button aircraft.
5. Hot Key Buttons o
Use the key combinations to toggle power
6. Ke.yboard. to the 3.5G/WLAN/Bluetooth modules,
7. Built-In Microphone = and check the LED indicator icon to see if
8. Touchpad & E the modules are powered on or not (see
Buttons m Tty ety 3 /
9. Fingerprint Module e o W B M T oy )

(Optional for
Models C - F Only)
10. LED Indicators

e 2. 2

(valid operation area)

1 - 8 System Map: LCD Panel Open - Models A & C
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System Map: LCD Panel Open - Models B & D

Figure1-4
ﬁ LCD Panel Open
s (Model B & D
Wireless Device Computers)

Operation Aboard Aircraft

1. Built-In PC Camera
(Optional)

2. LCD

3. Speakers

4. Power Button

5. Hot Key Buttons

6

7

8

The use of any portable electronic trans-
mission devices aboard aircraft is usually
prohibited. Make sure the module(s) are
OFF if you are using the computer aboard
aircraft.

Use the key combinations to toggle power

to the 3.5G/WLAN/Bluetooth modules,

and check the LED indicator icon to see if

the modules are powered on or not (see
/

Keyboard
Built-In Microphone
Touchpad &
Buttons
9. Fingerprint Module
(Optional for
Models C - F Only)
10. LED Indicators

).

Touchpad Buttons
(valid operation area)

System Map: LCD Panel Open - ModelsB & D 1-9
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=

©

Nogkrwd

Figure1-5
LCD Panel Open
(Model E& F
Computers)

Built-In PC Camera
(Optional)

LCD

Power Button

Hot Key Buttons
Keyboard

Built-In Microphone
Touchpad &
Buttons

Fingerprint Module
(Optional)

LED Indicators

System Map: LCD Panel Open - Models E & F

Wireless Device
Operation Aboard Aircraft

The use of any portable electronic trans-
mission devices aboard aircraft is usually
prohibited. Make sure the module(s) are
OFF if you are using the computer aboard
aircraft.

Use the key combinations to toggle power

to the 3.5G/WLAN/Bluetooth modules,

and check the LED indicator icon to see if

the modules are powered on or not (see
/

)-

\ 7
Touchpad Buttons
(valid operation area)

1-10 System Map: LCD Panel Open - Models E & F
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LED Indicators

- . Icon Color Description
The LED indicators on the computer display helpful .
information about the current status of the computer. Orange DC Power is Plugged In
Green The Computer is On
— D/ —
Icon Color Description Blinking Green The Computer is in Sleep
g Mode
[:] Green Hard Disk Activity Orange The Battery is Charging
EI Green Number Lock Activated m Green The Battery is Fully Charged
_ Blinking Oranae The Battery Has Reached
Green Caps Lock Activated 9 9 Critically Low Power Status
— Scroll Lock Activated (to activate G The (optional) Wireless LAN
Green press Fn & Scr Lk) (o) reen Module is Powered On
x The (optional) Bluetooth
. Orange Module is Powered On
Table 1 - 3 - LED Status Indicators

Table 1 -4 - LED Power & Communication Indicators

System Map: LCD Panel Open - ModelsE& F1-11
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Hot Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program, and allow you to toggle
the Silent Mode on/off with one quick button press.

Hot Key Function

Activate the Default E-Mail Browser

Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

SISIY

Table 1 - 5 - Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce comput-
er performance.

1-12 Hot Key Buttons & Keyboard
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Keyboard - Models A -D ~

The keyboard (Models A - D) has an embedded numerical keypad for easy numeric
data input, and features function keys to allow you to change operational features in-
stantly. See Table 1 - 6, on page 1 - 15 for full function key combination details. If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

Other Keyboards

()
(1 1]

: L
@ ¥ 3 % 7 AN : :
- 5 6 7
Play/Pause Key
. W ] T ¥ 5 08

J ol aKeR gl =3

Numerical Keypa

M0 < > - a7 +

Figure 1 - 6 - Keyboard - Models A - D NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special

characters. These special characters can only be produced by using the nhumeric keypad.
Regular number keys (in the upper row of the keyboard) will not work. Make sure that Num-
Lk is on.

Keyboard - Models A-D 1-13
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Keyboard - Models E & F

The keyboard (Models E & F) has a numerical keypad on the right for easy numeric data input, and features func-
tion keys to allow you to change operational features instantly. See Table 1 - 6, on page 1 - 15 for full function

key combination details.

_-.__

-~ﬁ wckspaca

er

r-"_T T’ T“ F$ zunction KeysIr-"-I"I I }PJ&‘I e..-I L glgrrp_llzl%ge‘ys

e

u I

J K ‘[L +— Entar
Numerical Keypad
N M < = 3.5G Module
Power
Toggle Key .
Alt B il ot

Figure 1 - 7 - Keyboard - Models E&F

1-14 Keyboard - Models E & F



Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed (see
“Hot Key” on page 4 - 6). When the driver is installed, an icon & will appear in the taskbar.

Quick Start Guide

Keys Function Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn+F7 Display Toggle
Fn + E 3.5G Module Power Toggle Q Q Fn + F8/F9 Brightness Decrease/Increase
B Feerem @ Powersn 1 £
Fn+F1 TouchPad Toggle \@ @ Fn + F10 PC Camera Power Toggle 1,1 =]
— - : = @ reeo 7 @ Pemerol
Turn LCD Backlight Off (( 3) iq)
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+Fll WLAN Module Power Toggle o 5‘1) o !
Fn+F3 Mute Toggle | Q Fn + F12 Bluetooth Module Power Toggle .
Volume*  On  Volume | Mute O Teeon .
o Normal Silent
Fn+F4 Sleep Toggle (@ Silent Mode Toggle mnde@ mndc@
En + E5/E6 Volume Decrease/increase *When enabled, Silent Mode will reduce fan noise and save power

consumption. Note this may reduce computer performance.

Table 1 - 6 - Function & Hot Key Indicators

Function/Hot Key Indicators 1 - 15
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System Map: Front & Left Views

Figure 1-8
Front & Left Views
2. DC-In Jack
3. External Monitor
Port

4, RJ-45 LAN Jack

5. Vent/Fan Intake/
Outlet

6. 2*USB 2.0 Ports

7. ExpressCard Slot
(see page 2-7) 4

8. 7-in-1 Card Reader

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) /

Note: Only one model is Mini SD (requires PC adapter) / RS MMC (requires PC adapter)
pictured here, however all

the ports are the same for
all the models.

1-16 System Map: Front & Left Views
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System Map: Right & Rear Views Fioure 1. 9
Right g Rear Views

=

S/PDIF-Out Jack
Microphone-In Jack
3. Headphone-Out
Jack

USB 2.0 Port
Optical Device
Drive Bay (for CD/
DVD Device)

6. RJ-11 Phone Jack
7. Security Lock Slot
8. Battery

n

ok

Note: Only one model is
pictured here, however all
the ports are the same for
all the models.

System Map: Right & Rear Views 1 - 17
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
1-18 System Map: Right & Rear Views



System Map: Bottom View - Models A -D
4

Battery Information

3

4 Model A& C
Computers

 Model B & D
Computers

Always completely discharge, then fully
charge, a new battery before using it. Com-
pletely discharge and charge the battery at
least once every 30 days or after about 20
partial discharges. See “Battery Informa-
tion” on page 3 - 10 for full instructions.

\ A/
2 &
CPU
The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating
make sure nothing blocks the Vent/Fan In-
take while the computer is in use.

Quick Start Guide

Figure 1-10
Bottom View
(Model A -D
Computers)

Battery
Bluetooth Module
Cover

RAM & CPU Bay
Cover

Vent/Fan Intake/
Outlet

Hard Disk Bay
Cover

3.5G USIM Card
Location

System Map: Bottom View - Models A-D 1-19
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Figure1-11
Bottom View
(Model E- F
Computers)

Battery

RAM & CPU Bay
Cover

Vent/Fan Intake/
Outlet

Hard Disk Bay
Cover

3.5G USIM Card
Location
Speakers

System Map: Bottom View - Models E & F

4

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharg-
es. See “Battery Informa-
tion” on page 3 - 10 for full
instructions.

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

1 - 20 System Map: Bottom View - Models E & F
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Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon 4, and then select Properties if you want to customize the appearance of the Start menu.

@) oeurogoms |

#1 Windows Update
<

‘ Open e Imternet

Explore o Emal

o
Search... u

Properties 7 Programs

= s, Documents
| Open All Users >

m‘ Explore All Users
T

B Control Panel

v
|=# Printers
L Taskbar and Start Menu

- "Tues

X0 'gbghéle;_cigs:—éic"_\;/iéw

e Start Sea O -

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Windows Vista Start Menu & Control Panel 1 - 21
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Video Features

This computer features two different (either SiS for Model A, B & E computers or NVIDIA for Models C, D
& F computers) video options. You can switch display devices, and configure display options, from the Display
Settings control panel (in Personalization) in Windows Vista.

To access Display Settings in Windows Vista:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click
Personalization > Display Settings).

3. Move the slider to the preferred setting in Resolution: o (Figure 1-13 on page 1 - 23).

4. Click the arrow, and scroll to the preferred setting In Colors: 9 (Figure 1 - 13 on page 1 - 23).

To access the SiS VGA Control Center (Models A, B & E):

1. The SiS VGA Control Center can be accessed by right-clicking the SIS Tray taskbar icon , and selecting
Control Center (or from the SiS VGA Control Center in the Windows control panel).

To access the NVIDIA Control Panel (Models C, D & F):
1. The NVIDIA Control Panel can be accessed by right-clicking the desktop, and then clicking NVIDIA Control
Panel (or from the NVIDIA Control Panel in the Windows control panel).

Note: After installing the video driver go to the Display Settings control panel to adjust the video settings to the
highest resolution.

1-22 Video Features
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Display Settings & Vldeo Control Panel/Center

I(mmp

Monitor |

Drag the icons to match your monitoes.

;memmunwwmam

1&@»&

e hest dniplay

Beolution:

Low

Hondulgelih

e

B |

Resolution

Refresh Rate -@
Rotate
About

Drag the icons 1o match yous morso

I Generic P Monitor on NVIDIA GeForce S300MG5. =

e

View
Sort By
Refresh

| Ittty Memtors

Paste
Paste Shortcut

1280 by BOD purey

NVIDIA Contrel Panel

Mew

Es, Personalize

Figure 1 - 13 - Display Settings & Video Control Panel/Center

Video Features 1 - 23
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 21) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

$ « Power Options

@ Balanced Battery life: @09
Change plan settings Performance: @89

) Power saver Battery life: 990900
Change plan settings Performance: : 00

) High performance Battery ife: 00
Change plan settings Performance: 908808

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 14 - Power Options

1 - 24 Power Options



Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
7-in-1 Card Reader
ExpressCard Slot

TouchPad and Buttons/Mouse
Audio Features

Adding a Printer

. |
Overview 2 - 1
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™ Hard Disk Drive

\ A/

’Ll‘ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page D - 4) with a height of 9.5 mm.

Before attempting to ac-

cess any of the internal L .
SO i e The hard disk is accessible from the bottom of your computer as seen below. For fur-

computer please ensure ther details see “Upgrading the Hard Disk Drive” on page 6-4.
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Models A & C Models B & D %dels E&F

Figure2-1
Hard Disk Location

. |
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “Storage” on page D - 4). The Sound Volume
optical device is usually labeled “Drive D:” and may be used as a boot device if Adjustment
properly set in the BIOS (see “Boot Menu” on page 5 - 12). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

To insert a CD/DVD, press the open button @ and carefully place a CD/DVD onto | gows. Click the Volume
the disc tray with label-side facing up (use just enough force for the disc to click onto | icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you | check the setting (see
are ready to start. The busy indicator @ will light up while data is being accessed, | Audio Features® on

. L ) . . ; 2-9).
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt- Page 2-9)
ed, insert an object such as a straightened paper clip into the emergency eject hole
to open the tray.
©toop Y Figure 2 - 2

Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1% Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be

CD Emergency Eject
accessed.

If you need to manually

gjecta CD (e.g-due to I\ RGR{el[[e)WWIgls)

an unexpected power

LIEERT RS CIER eV« Hold the CD or DVD by the edges; do not touch the surface of the disc.
EEREERCIE SRS  «  Use a clean, soft, dry cloth to remove dust or fingerprints.
f;{g'g}fi?ﬁgrg‘;‘gejﬂg « Do not write on the surface with a pen.

L SENEE el ¢ Do not attach paper or other materials to the surface of the disc.
GNeRETEEE R ETER ¢ Do not store or place the CD or DVD in high-temperature areas.
SUSCRREIEIREESUIIESE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRR e . Do not bend the CD or DVD.

db lodged i -
%ne hofe(?ome =S8l . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 18.

DVD Regional Coding

Table2-1

8 g g S — . .
Region Geographical Location . - : DVD Regional Coding
| General | DVD Region | Volumes | Diiver, | Details|
Most DVDs are sncoded for play in spec Toplay
1 USA, Canada resprilges VI sy el o s ack your BV vt
play discs from that region by selecting @ geograshic arca from the
following fist.
Western Europe, Japan, South CALTION, “Youi i Ghainge the esian 2 rled b of G
2 . . Aiter Changes remairing reaches 6o, you cannet change the region even
Afrlca, M |dd|e East & Egypt i you reinstall Windows or move your DVD drive to a diferent computer.

Changes remaining: 5

South-East Asia, Taiwan, South

To changs the curent regian, sslsct a gsographic arsa, and then dick OK

3 Korea, The Philippines, Indonesia, ,
United Arab Emirates -
Hong Kong Orited Kingdom
Uruguay
4 South & Central America, Mexico, e £
. Watican City -
Australia, New Zealand >
Curert Region: [Not Selected
5 N Korea, Russia, Eastern Europe, Newireosn | edo

India & Most of Africa

6 China

Optical (CD/DVD) Device 2 - 5



Features & Components

4

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure 2 -3
Left View

1. Card Reader

7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

* MMC (MultiMedia Card) e MS Duo (requires PC adapter*)
» SD (Secure Digital) * Mini SD (requires PC adapter*)
e MS (Memory Stick) * RS MMC (requires PC adapter*)

e MS Pro (Memory Stick Pro)

*Note: The PC adapters are usually supplied with these cards.

2 - 6 7-in-1 Card Reader
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ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

@ = === l

Inserting and Removing ExpressCards

» Align the ExpressCard with the slot and push it in until it locks into place (as
pictured in the generic figure below).

» To remove an ExpressCard, simply press the card to eject it.

4

ExpressCard
Slot Cover

Make sure you keep the
rubber cover provided in

the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

Figure 2 -4
Left View

1. Express Card
Slot

Figure 2 -5
Inserting &
Removing Express
Cards

ExpressCard Slot 2 - 7
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in

Mouse Driver

If you are using an ex- much the same way as a two-button mouse.
ternal mouse your op- . . “ "
erating system may be Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
able to auto-configure can configure the functions by double-clicking the TouchPad driver icon £ on the
_VOUf"mQUSG dU”I“Q Its taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
Installation or only en- motion and sensitivity options to your preferences. You will find further information
able its basic functions. )
e at www.synaptics.com.
device’s user docu- < KT ] [T e T ==
mentation for details. Buttons | Pointers | Pointer Options | Wheel [ Hardware | [ Devics Settings | [ Buttons | Ponters | Painter Options | Wheel | Hardware | @) Device Setings |
~ Button configuration - Synaptics Pointing Device - v10.0.12 17Aug07
& Right-handed " Lefthandsd .P'E‘.’. mePadvsz il |
Figu re 2 - 6 %E‘Pt‘rimawCl\dc (Nomal Select, Fr“gt’eﬁcundawClil:k{Curvte)\:t
B Nomal Drag) Menu, Special Drag)
Mouse Properties |
~Double Cick Speed- | Evcle |  Dsble | Setings.. |
E;;:I:ﬂudsc;hler;nu::gl: ;T:lwglé;?:;g If the folder does not
Slow J__ Fast D ~Tray lcon
"""""" " Remove tray icon from taskbar 420 PM
[ ?‘.“T':’n?‘m e T | " Static tray icon in taskbar ) 220PM
i - (& Apimated tray icon in taskbar T 420PM
Enables you to highlight or drag without helding down the mouse button. To set. —
briefly press the mouse button. To release. click the mouse button again
ket

2 - 8 TouchPad and Buttons/Mouse
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Audio Features

You can configure the audio options on your computer from the Sound “* control
panel in Windows, or from the Realtek HD Audio Manager g icon in the taskbar/
control panel (right-click the taskbar icon gl to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination.

4

Sound Volume
Adjustment

The sound volume level
is set using the volume

- = ) Realtek HD Audio Manager [PESEE =) control within Windows
-\]]] Sound Manager — — (and the volume func-
- R “@‘E‘““’“‘} dgf petis /, ot T tion keys on the comput-
#y Audio Devices - -
R ) . er). Click the volume
% System Sound Events e wul R el . icon in the t.aSKbar 1o
- Speaker Configuration | Sound Effects | Default Format . check the Settlng'
O P . ™
3 o
i:lf; Volume Control ‘ g
oy r.“.'—r”. Internal
| .j;é;:. Sound Recorder ]
Right-click the icon i R i
to access the menu Pty @
above. virtual Surround
I ) a0
%2 REALTEK (@]
.
Figure2 -7
Realtek Audio
Manager

Audio Features 2 - 9
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Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.

Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

arwbd

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer's USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

2 - 10 Adding a Printer



Power Management
Chapter 3. Power Management P
Overview OB Nwike

To conserve power, especially when using the battery, your computer power man- | Power  management

P functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
e The Power Sources best to refer to the user’s

« Turning on the Computer EE @ 7o EREE:

ing system.
« Power Plans a
» Power-Saving States (Note: All pictures used
» Configuring the Power Buttons on the following pages

are from the Windows

 Battery Information .
Vista OS.)

The computer uses enhanced power saving techniques to give the operating system Hibernate Mode In
(OS) direct control over the power and thermal states of devices and processors. For | Windows Vista SP1
example, this enables the OS to set devices into low-power states based on user set- _ :

. . . .. If you are using Win-
tings and information from applications. dows Vista SP1 with

4GB RAM installed, see
page 8 - 12 for informa-
tion on Hibernate.

. |
Overview 3 - 1



Power Management

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

3
. AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do | completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.

. |
3 - 2 The Power Sources
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Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow- Z
er button on the front panel. Shut Down

Note that you should al-
When the computer is on, you can use the power button as a Sleep/Hibernate hot- | ways shut your comput-
key button when it is pressed for less than 4 seconds (pressing and holding the power | erdown by choosing the
button for longer than this will force the computer to shut down). Use Power Op- | Shut Down command

. . . . . from the Lock Button
tions (Hardware and Sound menu) control panel in Windows Vista to configure | vicnu in Windows Vis-

this feature. ta. This will help prevent
hard disk or system
problems.

/ Connect To Switch User
Log Off

Control Panel Leck
Forced Off

Default Programs Restart

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow- Help and Support =i

Hibernate

er button for 4 seconds, or longer, to force the system to turn itself off. - Shurt Down
l-'.-ﬁ’ JETINGE

Power Button Sleep

Search

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).

| Windows Vista™

Turning on the Computer 3 - 3



Power Management

Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

4

Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

see Tables - L on § y\cond the computer into Sleep after a period of inactivity.

page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

e
33 « PowerOptions » Edit Plan Settings v | 42 [l search 2|

Change settings for the plan: My Plan 1

[EeRr=c=)

5 Power Options

Password

Advanced settings ‘

It is recommended that

Select the power plan that you want to customize, and
then choose settings that reflect how you want your

you enable a password
on system resume in or-
der to protect your data.

® Putthe computertoslecp: (15 minutes ~| [2hour - [On battery: [ L
Plugged in: Ves
- (= Hard disk B
Flgure 3-1 ' C change advanced power settings P | = Tumoff hard disk after
On battery: 10 Minutes
Power Plan

Advanced Settings

3 - 4 Power Plans

Choose the sleep and display settings that you want your computer to use.

j On battery

£ Pluggedin

@ Tum off the display: [5 minutes ] [20 minutes

Save changes

@

@ Change seftings that are currently unavailable

computer to manage power.

[My Created PLan [Active] v

= Additional settings
= Require a password on wakeup

Plugged in: 20 Minutes
[ Wireless Adapter Settings
@ Sleen

Restore plan defaults




Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-

ered.

I )5l » Conrotane > Pouer Optos Lo 0]

Require a password on wakeup

Choose what the power

Create a power plan

Choose when to turn off the
display

Change when the computer
sleeps

See also

Personalization

‘Windows Mobility Center

User Accounts

[E=EERES)

@
Select a power plan

Power plans can help you maximize your computer's performance or conserve
energy. Make a plan active by selecting it, or choose a plan and customize it by
changing its power settings. Tell me more about power plans

Plans shown on the battery meter

(7 Balanced Battery life: @20
Change plan settings Performance: @@e

() Power saver Battery life: @00990
Change plan settings Performance: @@

@ High performance Battery life: @@
Change plan settings Performance: #9999

Power Management

Figure 3-2
Power Plans

Power Plans 3 - 5
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4

Power Button

The Power Button [}
in the Start Menu (in
Classic View use the
Shut Down button |0])
can be used to send the
computer into a power-
saving state.

Sleep Mode &
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power.

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down

You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Log Off
Control Panel Lock
Default Programs Restart
Help and Support Sleep
Hibernate
| (V) E = ' Shut Down

Power-Saving States 3 - 7

Power Management
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Hibernate Mode In
Windows Vista SP1

If you are using Win-
dows Vista SP1 with
4GB RAM installed, see
page 8 - 12 for informa-
tion on Hibernate.

Figure 3-3
Lock Button Menu
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Configuring the Power Buttons

Z The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the

Password computer in to a power-saving state.
Protection

It is recommended that
you enable a password
on wake up in order to Define power buttons and turn on password protection

protect your data,. Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans,

@@g@ » Control Panel » Power Options » System Settings

@ Change settings that are currently unavailable

However you can dis-
able this setting from the
Power Options menu
by clicking Require a © whentpressthe power buttor: [sieep = -]

Power and sleep buttons and lid settings

] On battery J Plugged in

password on wakeup X
in the left menu, and se- @ whentprestneseppuon (TS

Shut down

lecting the options (click % When [ clase the lid [Steep -] [slesp -
Change settings that
are currently unavail-
able).

Password protection on wakeup

@ Require a password (recommended)
‘When your computer wakes from sleep, no one can access your data without entering the correct
password to unlock the computer. Create or change your user account password

Don't require a password
‘When your computer wakes from sleep, anyone can access your data because the computer isn't

Figure 3-4 locked.

Power Options
Define Power Save changes
Buttons

.|
3 - 8 Configuring the Power Buttons
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, 4
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status lcon :D-/(l) Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

will wake the system up.

Press the Power Button

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) _
Hibernate Press the Power Button Table 3_ 1
Orange (AC/DC adapter) Resuming
Display Turned Off Green Press a Key or Move the Mouse/Touchpad Operation

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down

hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9
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Battery Information

\ A/
’Ll\ Please follow these simple guidelines to get the best use out of your battery.
Low Battery

EITAE, Battery Power

WHERRGESEAEVASEEEE Y our computer’s battery power is dependent upon many factors, including the pro-
B EEEEV A grams you are running, and peripheral devices attached. You can set actions to be
B R taken (e.g. Shut down, Hlbe'rnate etc.), _and set critical and low battery levels from
S e e e power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

erwise, the unsaved

CEERULREEREE SRR Click the battery icon ([ in the taskbar to see the current battery level and charge
the power is depleted.

connect the AC/DC

) 5 Power Options ER==g
@ 54% available {plugged in, charging) Advanced settings
= Select the power plan that you want to customize, and
\13 then chaose settings that reflect how you want your
Solact B computer to manage power.
Elect @ power pian: @ Change settings that are currentl,
My Plan1 [MyPlan1 v
F' r 3 _ 5 @ Power saver aliattery
|gu e - Critical battery action
& Hi @ Low battery level
Battery Ilcon @:High'pertormance &) Critical battery level
= Low battery notification
(Taskbar) & Battery Onbatten: On L
H Learn how to conserve power Pluagedin: On =
Advanced Settings en & Lo bty acton =
More power options 7 be nothing o]
Windows Mohbility Center w?’o nothing =
eej
T «store plan defauts
—_— : Shut down D B
SRl
< v = el 0 gus AM (om0
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Conserving Battery Power

Use a power plan that conserves power (e.g Power saver), however note that
this may have an affect on computer performance.

Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

Reduce the amount of time before the display is turned off.

Close wireless (DO NOT use the Windows Mobility Center to power on/off
WLAN), Bluetooth, modem or communication applications when they are not
being used.

Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Battery Information 3 - 11
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 11 for information on the battery charge status, and to “Battery
Information’ on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)

.|
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Proper handling of the Battery Pack

» DO NOT disassemble the battery pack under any circumstances 7\[\1’:
» DO NOT expose the battery to fire or high temperatures, it may explode Callion

* DO NOT connect the metal terminals (+, -) to each other
Danger of explosion if
battery is incorrectly re-

o placed.
2 &

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t
3 turn off the computer even if a message indicates the battery is critically low, just let

the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.

2. Create a power plan for discharging the battery and set all the options to Never.

3. Click Change plan settings (after saving it) and click Change advanced power
settings.

 Power Optam

Change settings for the plan: Battery Discharge ’

Figure 3-6 ) onsem
Power Plan Create © Temotoedopier [nw. .

3 - 14 Battery Information



4,
5.

ECTy ©

Scroll down to Battery and click + to expand the battery options.
Choose the options below (click Yes if a warning appears):

Advanced settings ]

o Select the power plan that you want to customize, and
‘1‘; then choose settings that reflect how you want your
@ Change settings that are currently unavailable

computer to manage power.

[Bat‘tery Discharge [Active] -

[ Battery =
= Critical battery action
On battery: Shut down
Plugged in: Do nothing

= Low battery level ) il f
on battery (2:): I &= |
Plugged in: 0 % 3 L

= Critical battery level
On battery: 0 %

Plucaed in: 0 % £

Restore plan defaults

Advanced settings

Power Management

]

Select the power plan that you want to customize, and
‘fg then choose settings that reflect how you want your
computer to manage power.
@] Change settings that are currently unavailable
2]

l Battery Discharge [Active]

On battery: 0 %
Plugged in: 0 %

= Critical battery level
on baer ) S
Plugged in: 0 %

# Low battery notification

= Low battery action
On battery: Do nothing
Plugged in: Do nothing

|

Figure 3-7

| Power Options
Advanced Settings -
Battery

Restore plan defaults

Lok J[ Coned |

Low battery levels = 0%
Critical battery Levels = 0%
Low battery action = Do Nothing

[ ok ][ Canecel

)|

fopy ||

Critical battery action (On battery) = Shut Down
Critical battery action (Plugged in) = Do Nothing

Battery Information 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
3 - 16 Battery Information



Drivers & Utilities

Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

What to Install

The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page E - 29 for Windows XP information).

Module Driver Installation

The procedures for installing drivers for the PC Cam-
era, Wireless LAN, 3.5G and Fingerprint modules
are provided in “Modules & Options” on page 7 - 1.

What to Install 4 - 1




Drivers & Utilities

Driver In Stal | at| on 1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
Insert the Device Drivers & Utilities + User’s Manual this order) which is the same as that listed in the
disc and click Install Drivers/Option Drivers (button). Drivers Installer menu below.
2. Click to select the driver you wish to install, after
If you wish to install the drivers manually see overleaf installing each driver it will become grayed out. If
4 for the driver path information. you need to reinstall any driver, click the Unlock
button (you should uninstall the driver first).

|~ -3 Drivers Installer

S = Sy - 3. Follow the instructions for each individual driver
: installation procedure as listed on the following

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation



Driver - Windows Vista with Service Pack 1 Page
Video Page 4 -5
Audio Page 4 -5
Modem Page 4 -5
LAN Page 4 -6
TouchPad Page 4 -6
CardReader Page 4 -6
Hot Key Page 4 -6
PC Camera Module Page 7 -6
Wireless LAN Module Page 7 - 14
3.5G Module Page 7 - 18
Fingerprint Reader Module Page 7 - 27

Table 4 - 1 - Driver Installation

Drivers & Utilities

Manual Driver Installation

Click Browse CD (button) in the Drivers Installer ap-
plication and browse to the executable file in the ap-
propriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
6 for instructions.

4

Windows Vista Service Pack 1

Make sure you install Windows Vista Service Pack 1
(or a Windows Vista version which includes Service
Pack 1) before installing any drivers. Go to the Micro-
soft website for download details, or contact your service
center.

Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+" to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4 - 4 Driver Installation



Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Video
1. Click 1.Install Video Driver > Yes.

Models A. B & E (SiS):

2. Click Yes (click Yes if you want to view the
ReadMe file).
3. Click Yes to restart the computer.

Models C, D & F (NVIDIA):

4. Click Next.
5. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play Settings control panel to adjust the video settings
to the highest resolution (see “Windows Vista Start
Menu & Control Panel” on page 1 - 21).

Drivers & Utilities

Audio

1. Click 2.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Modem

1. Click 3.Install Modem Driver > Yes.

2. Click OK.

3. The modem is ready for dial-up configuration.

4

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.

Driver Installation 4 - 5
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LAN

1. Click 4.Install Lan Driver > Yes.

2. Click Next.

3. Click Finish > Finish to restart the computer.
4. The network settings can now be configured.

TouchPad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click Finish > Restart Now to restart the com-
puter.

CardReader

1. Click 6.Install Cardreader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Hot Key

1. Click 7.Install Hotkey Driver > Yes.

2. Click Next > Install.

3. Click Finish > Finish to restart the computer.

4 - 6 Driver Installation

4

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1.

2.

Click Start, and click Control Panel (or point
to Settings and click Control Panel).

Click Check for updates (Security), or
double-click Security Center and click
Windows Update.

Double-click Check for updates (button).
The computer will now check for updates
(you need to be connected to the internet).
Click Install now (button) to install the
updates.



Optional Drivers

See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

.1 Drivers Installer
g .

I "Nlobj_le Cdi:rmulin i

Please follow steps from top to bottom in order to install Option drivers.

(=T

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Drivers & Utilities

Bluetooth Module

Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 7 - 2
for configuration instructions.

PC Camera Module

See the introduction in “PC Camera Module” on
page 7 - 6, and check the installation procedure.

Wireless LAN Module

See the introduction in “Wireless LAN Module” on
page 7 - 14, and check the installation procedure.

3.5G Module

See the introduction in “3.5G Module” on page 7 - 18,
and check the installation procedure.

Fingerprint Reader Module

See the introduction in “Fingerprint Reader Module”
on page 7 - 27, and check the installation procedure.

Driver Installation 4 - 7



Drivers & Utilities



BIOS Utilities

Chapter 5: BIOS Utilities "

OverVieW BIOS Settings
Warning
This chapter gives a brief introduction to the computer’s built-in software: _
Incorrect settings can
Diagnostics: The POST (Power-On Self Test) ;a;ffm)t/,zf ng ifr?;(;:o
mistakes, return to Set-
Configuration: The Setup utility up and restore the Set-

If your computer has never been set up, or you are making important changes to the e SIERTIUEGEE

system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

. |
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4

POST Screen

1.BIOS information
2.CPU type

3.Memory status

4.Enter Setup prompt
appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure5-1
POST Screen

The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

Phoenix TrustedCore(tm) NB

Copyright 1985-2006 Phoenix Technologies Ltd.
All Rights Reserved

Bios Revision: ****kxx*

KBC/EC Firmware Revision: ****#%%x

CPU = 1 Processors Detected, Cores per Processor = 29
Intel(R) Core(TM)2 Duo CPU T5400 @ 1.50GHz

2046M System RAM Passed

2048 KB L2 Cache

System BIOS shadowed

Fixed Disk 0: FUJITSU MHV2100BH PL

ATAPI CD-ROM: Optiarc CDRWDVD CRX890S

Mouse intialized

Press <F2> to enter SETUP e

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

e Press <F1> to resume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

.|
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The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Program
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Setup Screens

The following pages contain additional advice on portions of the Setup. 2
) ] ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screento | Thé  Setup  menus
ke ch to Set shown in this section are
make changes 10 Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- S
screen. If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p“att_e for your
then use the arrow keys to scroll up or down the page. mocet and opfions.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

The Setup Program 5 - 5
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Main Menu

PhoenixBIOS Setup Utility

Figure 5 - 2 I Main Advanced Security Boot Exit
Main Menu (EB:12:05] Item Specific Help
System Date: [08/23/2008]
» IDE Channel 0 Master [None] b e b
» SATA Port 1 [FUJITSU MHV2100BH PL] <iele>, <SiEE UEb>, oF
» SATA Port 2 [Optiarc CDRWDVD CRX8] <omteE> selecEs Eielel,
System Memory 633 KB
Extended Memory 2045 MB

BIOS Revision kK kK kK

KBC/EC Firmware Revision Kk K kK kK

VGA Card: Kk Kk KKK
VBIOS Revision: ok ok ok ok kK
VBIOS Build Date: * kKK kK kK
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

. |
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IDE Channel 0 Master (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of an optical Device/
HDD on the computer’s IDE Channel. Use the Auto (Type:) setting to have the items
configured automatically for you.

SATA Port 1/2 (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Port 1/2. Use the Auto (Type:) setting to have the
items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

VGA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
This item contains information on the video card installed and the video BIOS.

. |
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Advanced Menu
PhoenixBIOS Setup Utility

m Advanced Security Boot Exit

Item Specific Help
ivIsTAl
SATA Mode Selection: [AHCI] X
Legacy USB Support: [Enabled] Select t':he Operating
Boot-time Diagnostic Sdreen: [Enabled] sysitem dmstallcel X
Power on Boot Beep [Disabled] on yo“.lr system which
Battery Low Alarm Beep: [Disabled] you will use most
commonly.
Figure5-3
d d Note: An incorrect
A vance Menu ) ) : ) setting can cause
Only available if Windows Vista some operating
is selected as the O/S e e
' unexpected behavior.
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

Installed O/S (Advanced Menu)

This setting tells the computer what kind of operating system you’re using. Make
sure you choose the correct setting for your O/S in order to prevent system problems.
Note: If you select the Vista O/S then the SATA Mode Selection menu will become
available. If you are installing the Windows XP O/S make sure you have set the ap-
propriate operating system here in order to prevent system problems.

I
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SATA Mode Selection (Advanced Menu)

This menu is only available if you select the Vista O/S as your operating system.
You can configure SATA (Serial ATA) control to operate in either IDE (native/
compatible) or AHCI (Advanced Host Controller Interface) modes from this menu.
The SATA mode should be set to AHCI mode for this system (unless you are sure
your hard disk can only operate in IDE mode). If you are unsure of the mode your
hard disk supports contact your service center.

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus in
non-USB aware operating systems.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen.

Power on Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Advanced Menu 5 - 9
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P Security Menu

PhoenixBIOS Setup Utility

Security Menu Security
The changes you . Item Specific Help
Supervisor Password Is: Clear
make here affect the User Password Is: Clear
Supervisor Password
a(.?(.:eSS. to the Setup IEnter]] controls access to the
Utlllty |tse|f, and also Set User Password [Enter] setup utility.
acf:ess '_:o your ma- Password on boot: [Disabled]
chine as it boots up af- Fixed disk boot sector: [Normal]
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.
Help Select Item Change Values Setup Defaults
H Exit Select Menu Select PSub-Menu Save and Exit
Figure5-4
Security Menu Set Supervisor Password (Security Menu)

You can set a password for access to the PhoenixBI1OS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).

5 - 10 Security Menu



Set User Password (Security Menu)

You can set a password for user mode access to the PhoenixBIOS Setup Utility.
This will not affect access to the computer OS, (only the Setup utility) unless you
choose to set a Password on Boot (see below). Many menu items in the Phoenix-
BIOS Setup Utility cannot be modified in user mode. You can only set the user
password after you have set the supervisor password.

Password on boot: (Security Menu)

Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)

If you choose “Write-Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).

Security Menu 5 - 11
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Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled®), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Boot Menu

. PhoenixBIOS Setup Utility
Flgure 5 - 5 Main Advanced Security Boot Exit
Boot Menu

Item Specific Help

Boot priority order:
Keys used to view or

2: 1IDE CD: Optiarc CDRWDVD CRX890S-(S configure devices:

BF: IDE HDD: FUJITSU MHV2100BH PL-(S1) U 4d D

4. USB KEY: o an own érrows

5: USB FDC: select a device.

6: USB CDROM: <+> and <-> moves

7: PCI BEV: SiS1991 UNDI, PXE-2.1 the device up or down.

8: 3

Excluded from boot order: = exc}ude o imelues

USB ZIP: the device to boot.
USB LS120: <Shift + 1> enables or

disables a device.
<l - 4> loads default
boot sequence.

Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

5 - 12 Boot Menu
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PhoenixBIOS Setup Utility Figure5-6
Main Advanced Security Boot Exit Exit Menu
Item Specific Help
Exit Discarding Changes Exit System Setup and
Load Setup Defaults save your changes to
Discard Changes CMOS .

Save Changes

Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

. |
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview

| ins informai | L
This chapter contains information on upgrading the computer. Follow the steps out- —
lined to make the desired upgrades. If you have any trouble or problems you can con- Warranty Warning

tact your service representative for further help. Before you begin you will need: Please check with your

« A small crosshead or Phillips screwdriver service  representative

. before undertaking an
» Asmall regular slotted (flathead) screwdriver upgrade procedurges tz)/

* An antistatic wrist strap find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

. |
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

* Your system is still under warranty or a service contract
* You don’t have all the necessary equipment

* You’re not in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

2N\
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery ™

If you are confident in undertaking upgrade procedures yourself, for safety reasons ’ﬁl\ _

it is best to remove the battery. Warranty Warning
Turn the computer off, and turn it over. Please check with your
Slide the latch @ in the direction of the arrow. service representative

Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any

Slide the battery out in the direction of the arrow @. ;{pgrad:a_fp;]qced'ﬁlln\a/sb |t8
ind out if this wi

your warranty.

PwnE

Figure 6 -1
Battery Removal

Removing the Battery 6 - 3
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o Upgrading the Hard Disk Drive

\ A/
’Ll\ The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
HDD System disk drives with a height of 9.5mm (h) (see “Storage” on page D - 4). Follow your
SUELUIRE operating system’s installation instructions, and install all necessary drivers and util-

N Rl el ties (See “Driver Installation” on page 4 - 2), when setting up a new hard disk.

fore you begin make sure: )
You have backed up any 1. Turn off the computer, and turn it over and remove the battery.

data you want to keep from 2. Locate the hard disk bay cover and loosen screws @ & @.

your old HDD. 3. Remove the hard disk bay cover @.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Models A & C Models B & D Models E & F
—

Figure 6 - 2
Hard Disk Bay
Cover Removal

6 - 4 Upgrading the Hard Disk Drive
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4. Grip the tab and slide the hard disk in the direction of arrow @.
5. Lift the hard disk out of the bay @.

(-1

Figure 6 - 3
HDD Removal

Figure 6 -4
HDD Cover
Removal

Models E & F

Upgrading the Hard Disk Drive 6 - 5
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6. Remove the screw(s) @ / @ & @ and the adhesive cover @ (note that Model E
& F's adhesive covers are not attached by screws).
7. Reverse the process to install a new hard disk drive (do not forget to replace all the

screws and covers).

Figure6-5
HDD Cover
Removal

Models E & If\ - :

6 - 6 Upgrading the Hard Disk Drive
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Upgrading the Optical (CD/DVD) Device

\ A/
1. Turn off the computer, and turn it over and remove the battery. ’Q‘
2. Models A & C: Locate the RAM & CPU bay cover and remove screws 0 - e Fan Cable
3. Carefully (afan and cable are attached to the under side of the cover) lift up
the bay cover. Make sure you recon-

4. Carefully disconnect the fan cable @), and remove the cover @. MEE s 1M e €

OR
5. Models B, D, E & F: Locate the hard disk bay cover and loosen screws @ & @.
6. Remove the hard disk bay cover @.

before screwing down
the bay cover.

) € R e Figure 6 - 6
_Models A& C Models B & D H%’dels E&F Removing the RAM
& CPU Cover/HDD
Cover

Upgrading the Optical (CD/DVD) Device 6 - 7
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7. Remove the screw at point @), and use a screwdriver to carefully push out the
optical device at point @.
8. Reverse the process to install the new device.

Figure 6 - 7 Models A & C
Removing the
Optical Device | vy ] -

¢ Models B - F

6 - 8 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page D - 3 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws @ - @.

Figure 6 - 8
RAM & CPU
Bay Screws

<o

Models B & D
® 3

2

Models-E &F
s 3

Upgrading the System Memory (RAM) 6 - 9



Upgrading The Computer

3. Carefully (a fan and cable are attached to the under side of the cover) lift up
the bay cover.
4. Carefully disconnect the fan cable @, and remove the cover @.

T

-]

Figure6-9
CPU/RAM Bay
Cover Removed

2N\
I

Fan Cable

Make sure you reconnect the fan cable 4 before screwing down the bay cover.

6 - 10 Upgrading the System Memory (RAM)



Upgrading The Computer

5. Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows (@ & @) in Figure 6 - 10.
Figure 6 - 10
RAM Module
Release Latches

L SO

7

M6ETQSI-1G o

BISONT.3M
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6. The RAM module will @) pop-up, and you can remove it.

Figure 6 - 11
RAM Module
Removal

7. Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

.|
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11. Replace the bay cover and screws (make sure you reconnect the fan cable

before screwing down the bay cover).

Note for Model B & D computers that there are four cover pins, and for Model E
& F computers there are three cover pins. These pins need to be aligned with
slots in the case to insure a proper cover fit, before screwing down the bay cover.

Models B & D

Figure 6 - 12
Cover Pin
Alighment

12. Restart the computer to allow the BIOS to register the new memory configuration

as it starts up.

Upgrading the System Memory (RAM) 6 - 13
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Figure 6 - 13
3.5G & WLAN
Module Location

1. WLAN Module
2. 3.5G Module

Note: Only one model
is pictured here hover
the location of the
modules are the same
for all the models.

3.5G and WLAN Module Location

The picture below indicates the location of the 3.5G and WLAN modules for your
information. Note that the 3.5G module is a factory option, and the WLAN module
is an option. Neither of these modules are user upgradeable/replaceable; for more in-
formation contact your customer service representative.

|
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Chapter 7. Modules & Options

Overview

This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

* Bluetooth Module

* PC Camera Module

*  Wireless LAN Module

» 3.5G Module

» Fingerprint Reader Module

2N\Z
A

Important Notice

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropri-
ate antennas will be installed. Note that In order to comply with FCC RF exposure compli-
ance requirements, the antenna must not be co-located or operate in conjunction with any
other antenna or transmitter.

Modules & Options

\ 7/
L&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft.

Overview 7 - 1
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Bluetooth Module

SN

. ’Ll‘ _ The operating system’s Bluetooth Devices control panel is used to configure the
Wireless Device Bluetooth settings in Windows Vista, and therefore does not require a driver. Use
CIpEreien AEgend the Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 -

Alrcrait 15) to toggle power to the Bluetooth module.

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

4

Bluetooth Data Transfer

you are using the computer
aboard aircraft.

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.

7 - 2 Bluetooth Module



Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On

1. Pressthe Fn + F12 key combination to power on the Bluetooth module.

2. A Bluetooth icon EJ will appear in the taskbar (see sidebar).

3. You can then do any of the following to access the Bluetooth Devices control
panel.

« Double-click the icon gg to access the Bluetooth Devices control panel.
* Click Start, and click Control Panel (or point to Settings and click Control Panel), and then
click Bluetooth Devices (Hardware and Sound).

« Click/Right-click the icon gg and choose an option from the menu.
) Buetcoth Devices |

Dievices | Opters | COM Port | Hartware | Add a Bluetooth Device

Computen tworkstations, servers, lapteps, PO,
o

| iy e

|
Show Bluetooth Devices

| Send a File

Receive a File
Join a Persenal Area Metwork
Open Bluetooth Settings

Remove Bluetooth Icon

[ox ][ cance

Modules & Options

4

Bluetooth Taskbar
Icon

If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth Devices
control panel. Click Op-
tions (tab), and make
sure that Show Blue-
tooth icon in the notifi-
cation area check box
(Connections) has a
tick inside it.

Note that you will need
to check the LED indica-
tor to see if the module
is powered on or not.

Figure7-1
Bluetooth Devices &
Click Icon Menu

Bluetooth Module 7 - 3
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel.

2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to
this computer check box (Connections) has a tick inside it.

3. Click Devices (tab), and then click Add.
Figure 7-2 4. The Add Bluetooth Device Wizard will appear.
Add Bluetooth 5. Click to select “My device is set up and ready to be found”, and then click Next.
Device Wizard VG | e — —y
mﬁoﬁm&t}::ﬂc Add Bluctooth - 9
-_h BEAR l_ ZREFCO00 .
/ My o

Passkey Options

) 7o dont e 1o e Pt o wart 10 034, ks e P 1.
L o ek o ek b e bt e
et e s e A st o

You can allow the sys-
tem to choose a pass- __ S - o

key for you. You will 6. The Wizard will then search for any available Bluetooth devices within range.
then be prompted toen- £ 7 cjick to select the device you want to communicate with, and click Next.

ter the generated pass- ' : - .
e @ g e 8. Select an appropriate passkey option and click Next.

device.

(e [ omen (| =

Figure 7 - 3
Passkey Option

9. Click Finish.

7 - 4 Bluetooth Module
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel. /
2. Click on the device you want to change and click Properties to:

¢ Change the name of the device (click General, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth
To Make your Computer Discoverable to Bluetooth Devices configuration and set-

. tings, select Hel d
1. Access the Bluetooth Devices control panel. oS mE el

. . . . . Support from the Start
2. Click Options, and make sure that Allow Bluetooth devices to find this menu. Type Bluetooth in

computer check box (Discovery) has a tick inside it. the Search Help box,
3. Make sure that Alert me when a new Bluetooth device wants to connect check box and select an item from
(Connections) has a tick inside it, if you want to be notified when a Bluetooth the returned search re-
device wants to connect. sults to get more infor-
£) Bluetooth Devices k@g mation.
| Devices| Options [ COM Ports | Hardwars | | \
Discovery
(] fllow Bluetooth devices to find this computer:
i Bt Figure 7 - 4
Connections .
7] Alow Bluetaoth devices to gonnect to this compter Bluetooth Devices
[¥] Alert me when a new Bluetooth device warts to connect .
= = Options
[7] Show the Bluetooth icon in the netification area p
Change settings for 3 Bluetooth enabled device.
ok (oo ] [Coomy )

Bluetooth Module 7 - 5



Modules & Options
PC Camera Module

\ A/
’Q\ The PC Camera module uses the BisonCap application to capture video files. Be-
Latest PC Camera fore installing the PC Camera driver, make sure that the optional PC Camera is on.
DU el Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on page 1
Check the Device Driv- - 15) to toggle power to the PC Camera module. Make sure you install the drivers

ers & Utilities + User’s in the order indicated in Table 4 - 1, on page 4 - 3.
Manual disc, and any

accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.

. |
7 - 6 PC Camera Module
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PC Camera Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/ 7Zl'<
DVD drive. 2.0M PC Camera
2. Click Option Drivers (button). Screen Refresh
3. Click 1.PC Camera, Web cam > Yes. T —
4. Choose the language you prefer and click Next > Next. module  supports  a
5. Click Finish to restart the computer. frame rate of 12 fps. If
6. Run the BisonCap application program from the BisonCam shortcut on the you find that the screen
desktop, or from the BisonCam item in the Start > Programs/All Pro- refresh rate is subject to

grams menu (if the hardware is turned off use the Fn + F10 key combina- PR ST, e e
duce the window size,

or adjust the Output

tion to turn it on again).

Size  and/or  Color
Space Compression.

To reduce Output Size
and/or Color Space
Compression run the
BisonCap application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.

. |
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Sound  (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is
not disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.

7. Click OK and close the control panels.

8. Runthe BisonCap application program from the Start > Programs/All Programs
> BisonCam menu.

9. Go to the Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

7 - 8 PC Camera Module



Disable

Show Disabled Devices

v Show Disconnected Devices

Configure Speech Recognition...

Properties.
Right-click
_setDefaut

: " Microphane Properties - [=2=)
Playback | Recording |sounds o O i
’ ) - [ General | Levels [Enhancements | Advanced
Select a recording device below to modify its settings:
L4 Microphone i
Realtek High Definition Audio —
&) Working ? I O 1o [ Batance |

Microphone Boost

i 0

{+200d8

f-DEI.ricvﬁs] Options  Capture  Help

[_Captule ] Help

¥ BisonCam, NB Pro

v Microphone (Realtek High Defini

Start Capture

Stop Capture

v Capture Audio
Set Time Limit...

Modules & Options

Figure 7 -5
Audio Setup for PC
Camera
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BisonCap
4 BisonCap is a video viewer for general purpose video viewing and testing, and for

_ _ capturing video files to .avi format.
Pre-Allocating File

Space 1. Runthe BisonCap program from the Start > Programs/All Programs > Bison-
You may pre-allocate the Cam menu (it is recommended that you set the capture file before the capture
file size (File > Allocate process - see Set Capture File below).
File Size) for the capture 2. Goto the Capture menu heading (if you wish to capture audio check “PC Camera
file in the BisonCap pro- Audio Setup” on page 7 - 8) and select Start Capture.
gt 3. Click OK (the file location will be displayed in the pop-up box) to start capturing the

Pre-allocating space on video, and press Esc to stop the capture (you can view the file using the Windows

the hard disk can improve Media Player).

the capture quality (par-

ticularly of large capture Set Capture File

files), by reducing the § prinr to capturing video files you may select the Set Capture File... option in the
amount of work the hard . . . . . .

disk has to do in finding | 1€ menu, and set the file name and location before capture (this will help avoid ac-
space for the video data | cidentally overwriting files). Set the name and location then click Open, then set the
as it is being captured. “Capture file size:” and click OK. You can then start the capture process as above.
See aiso "Reducing Vid- § - o6 the important information in “Reducing Video File Size” on page 7 - 11 in
eo File Size” on page 7 -

11. order to save file space, and help prevent system problems.

7 - 10 PC Camera Module
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 10), limit the file size of the captured video (see “Pre-
Allocating File Space” on page 7 - 10) or reduce video resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Runthe BisonCap program.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

. |
PC Camera Module 7 - 11
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Eliminating Screen Flicker

If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Runthe BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Properties :
Property Page | Video Proc Amp | Camera Control 1
¥ Auto White Balance [ RGE gain
~ Environment R < |
+ ,ALI‘tO " Tungsten G J _J
7 " Daylight " Fuorescent g b
Rotation Frequency 1
™ Horizontal [ Vertical " Disable ¢ S50Hz % 60Hz
i [~ Effect Mod
Figure 7 - 6 ect Mod
I i - Effect
Video Capture Filter . S
I~ Low Light Mode
" EMBOSE  NEGATIVE
Reset
oK | Cancel ‘ ‘

7 - 12 PC Camera Module
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Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Runthe BisonCap program.
2. Goto Zoom and select Zoom Out/Zoom In.

I Zoom | Help

Zoom Cut

Figure 7 -7
Zoom/Setting

foomIn

SN
A&

Snapshot Folder

Taking Still Pictures

The BisonCap program allows you to take still pictures.
The Snapshot folder’s

1. Runthe BisonCap program. default location is on the
2. Goto Options and select Take Picture. de_sktop. Do not move
3. The picture (in JPEG format) will be placed in the Snapshot folder ﬁ |on the this folder or an error

desktop. j may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

PC Camera Module 7 - 13
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Wireless LAN Module

\ A/
’Q‘ If you have included a 802.11b/g WLAN module in your purchase option, make sure

Wireless Device that the Wireless LAN module is on before installing the driver.
Operation Aboard

Alfcrait Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1

WCEEEEE A c DR - 15) to toggle power to the Wireless LAN module. Make sure you install the drivers

S e BIEERE  in the order indicated in Table 4 - 1, on page 4 - 3.
vices aboard aircraft is usu-

ally prohibited. Make sure
GEEEREOREECIE S EE  802.11b/g Driver Installation

you are using the computer

aboard aircraft. 1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Wireless Lan > Yes.

Choose the language you prefer and click Next.

Click Next > Install.

Click Finish to restart the computer.

Use the Fn + F11 key com-
bination to toggle power to
the  WLAN module, and
check the indicator to see if
the module is powered on
or not (see

/

).
e e @ Note: The operating system is the default setting for Wireless LAN control in Win-

Ve G e @ dows Vista (see overleaf).
on/off the WLAN module as

this can cause some unex-

pected behavior.

ISR e N
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon [, and then click Connect to a network (or right-
click the icon B, and then click Connect to a network).

_ Figure 7 - 8
CConnectto a network > Taskbar Men us

Turn on activity animation

Mot Connected

:, Wireless networks are available.

> Turn pff notification ofn networks
* Click icon Right-e1i¢k ieon
D\agnoseand repair
onnect to a network : /
NETT ST TS Srier MNetwaork and Sharing Center

g B Sy L

Network and
Sharing Center

2. Inthe Show list, click to choose Wireless from the drop-down menu.
3. Alist of currently available networks will appear.

You can also use the Net-

) e
(L) % comeatioaneruont I q work and Sharing Cen-

ter control panel in
Windows (Network and

Select a network to connect ta

" L] Internet) to connect to
8 G S Lm ol any available wireless
. networks.
Ky e Security-ensbled netwark ol |
5- WLAND Security-enabled netwark Al
| i - Figure7-9
Connect to a

‘ — Network

Wireless LAN Module 7 - 15
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Click a network, and then click Connect.

If you do not see a network you want to connect to, click Set up a connection or
network (a list of options will appear allowing manual searching, and creating a
new network).

o~

(D % Connectta s netwnr @ W Connect 1o 2 network ﬁ
- Connecting to WLAN Choose a connection aption
Figure 7 - 10 o
Connecting Ad '™ | @
[
| [ i
< Josuety
(i ] =
6. Move the cursor over the taskbar icon B to see the connection status (see below).
Currently connected to
‘. Network.com{WLAN1) all
Figure 7 - 11 up~ Access Local only l_l!!_u

Connection Status

TR 6 1120 AM
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7. Todisconnect from the wireless network you can click the taskbar wireless icon [&J,
and then select Connect or disconnect to access the network menu, and click 7£l<
Disconnect (or right-click the icon B, and then click Disconnect from).

Security Enabled

Currently connected to: = Networks
Connect to a network . -~ A
f = B
s R‘::":gkf;r:l(ownll‘mn !!!‘_'U You should try to make
|| . ClICk iCOI’]}r Disconnect or connect to another network sure that any network you
- how @ ) are connecting to is a se-
onnect or disconne
<CEnnect or disconnedt> 7 cure network.
Network and sharing Center = —
ﬁ WLANI Connected =
Connecting to unsecure net-

works may allow unautho-
rized access to your
Security-enabled network !ﬂ]] T computer, documents, web-

sites and files etc.
Set up a connection or network
Open Netwerk and Sharing Center

B

Security-enabled network

» Figure 7 - 12
Disconnecting

Metwork.com{WLANT) Disconnect from

onnect to a network

Turn on activity animation

Turn off notification of new networks

Right-click icon

Diagnose and repair

P — Network and Sharing Center
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™ 3.5G Module

RS : . .

‘ If you have included an optional 3.5G module (see “Communication” on page D -
Power Safety 5 for specification details) in your purchase option, you will have the appropriate

Warning

software provided for your module. Follow the instructions below to install the
S eniieEcel il USIM card (which will be provided by your service provider), and then install the

any installation proce- application.

dures, make sure that . . L .
ek i Before installing the application, make sure that the 3.5G module is on. Use the

eEsEnEG el Fn+([2]) key combination (see “Function/Hot Key Indicators” on page 1 - 15) to
SeREURREEIEEREUCEE  toggle power to the 3.5G module. Make sure you install the drivers in the order in-

e RIS ES ] dicated in Table 4 - 1, on page 4 - 3.
phone lines). It is advis-

SECESENEERENER 1. Turn off the computer, and turn it over and remove the battery.
SRR 2. Locate the SIM card cover and loosen screw @.

VSRV 3 Remove the SIM card cover (2]
the machine on. ' )

Figure 7 - 13
SIM Card Cover
Removal

Note: Only one model is
pictured here.
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4. Insert the USIM card as you would into your mobile phone.
5. Slide the SIMLOCK towards the hinge in order to release the lock and lift it up.
6. Insert the USIM card as illustrated in (Figure 7 - 14) and close the SIMLOCK.

Figure 7 - 14
Insert the USIM
Card
7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 15 until
it clicks into the lock position.
Figure 7 - 15

SIMLOCK Lock

3.5G Module 7 - 19
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N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + @ key com-
bination to toggle power to
the 3.5G module, and
check the indicator to see if
the module is powered on
or not (see

/

).

Figure 7 - 16
3G Watcher
Application

7 - 20 3.5G Module

3G Watcher Application

With the 3.5G module and USIM card (provided by your service provider) installed
you may then install the 3G Watcher application. The 3.5G Watcher application al-
lows you to directly access your 3.5G internet service from the computer.

3G Watcher Application Installation

1.

wmn

N O~

Enable power to the module by pressing the Fn + [77] key combination (the

on screen icon , < will indicate the module’s power status).

If a Found New Hardware window appears, click Cancel.

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 3.3G Driver > Yes.

Click Next.

Click the button to accept the license agreement, and then click Install.
When the next screen appears wait (about 2 minutes) until the 3G
Watcher application appears on screen (as per Figure 7 - 16) before
clicking Finish (this allows the hardware to detect the 3.5G module).

3G Watcher

Toals

SIERAA WIFELESE
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Setting Up a Carrier Profile
Although the connection information is stored on the USIM card supplied by the ser-
vice provider, you will need to set up the appropriate carrier profile in 3G Watcher.

1.
2.

3.

Power on the 3.5G module using the Fn + key combination.

Access the 3G Watcher application from the Start menu (Start > Programs/All
Programs > Sierra Wireless > 3G Watcher), or by clicking the desktop icon E
Click Tools and select Options.

Click Profiles and then click the Add new profile button &, and select WWAN
profile.

P Uie: Options

= 1|

=l Mewaging Profites
Connections... = ﬁ::?::...u\ e N Yt o Fi ure 7 - 17
SMIS Expresss: -FarEas Tone - ! l l g .
=D Add WWAN Profile
Call Histery... = ) _ ]
Phone Book... — _) -

Turn Radic Off 3
Options... ' @ e e
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5.  You can then enter a new profile name or choose a profile from the drop-down list
provided by the software (see the sidebars for information on the profile details).

Figure 7 - 18 Jser Options.
/ rj Messaging -
<L Netwark

User Options

Profile Information & SIM Settings o )
Z 9 Sounds Temrrey
Click General and/or Ad- @___(:I;’fc":zngm reecom ] | Possvord

APN (Access Point Mame)
Connection type (Autoconnect etc.)
PDP type

691 Jb Deafie

menus under Advanced) "7-”_
in the left menu, and then LGl Advanced L
click in any of the fields to ‘ e
add the appropriate infor- el Bt
mation supplied by your
service provider. ok J[ cancel |[ ooy |

Profile Details

vanced (and the sub-

If you have chosen the
profile from the drop-
down list then most of the
information in the Gener-
al and Advanced tabs
should be automatically
filled in for you (however
check with your service
provider for the latest in-
formation as you may at
least need to add in your
Username and Pass-
word).

INTC {New Telephone Co)

o

Click Apply > OK to save the information.
You can choose the profile from the pull-down menu.

N

7 3G Watcher

View Tools

Figure 7 - 19
Choose Profile

SIERARA WIRELESR

. |
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Connecting to the Service Provider )

1. Power on the 3.5G module using the Fn + key combination.

2. You can access the 3G Watcher application from the Start menu (Start >
Programs/All Programs > Sierra Wireless > 3G Watcher), or by clicking the
desktop icon .

3. The software will run and display the service provider name (see “Setting Up a
Carrier Profile” on page 7 - 21).

T 3G Watcher

Tools

Figure 7 - 20
Connect Button

BIERRA WIRELESER

4. Click Connect to begin the connection process.
5. The 3G Watcher application will then display the connection information in the
window.

T 3G Watcher

Figure 7 - 21
Connecting

SERRA WIRELESE
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Figure 7 - 22
Connected
Taskbar
Notification

Figure 7 - 23
3GWatcher
Connected

7 - 24 3.5G Module

6. When the connection is successful a taskbar notification will appear (as below).

7. You can then access the internet, download e-mail etc. as per any internet
connection.

8. While you are connected the taskbar icon will be green - (it will be red - when
the program is running but not connected).

9. To disconnect click the Disconnect icon.

T 3G Watcher

Tools

Wiew.

SIERRA WIRELESR

10. The program will disconnect from the service provider. _
11. The module will still be on, and you will need to press the Fn + key

combination.
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12. If you click the 3G Watcher close icon [ a message will be displayed asking you
to click OK to confirm the program exit.

Warning (3]

¢ Figure 7 - 24
A Exit Warning

‘You have requested to exit 3G Watcher.

[ Do not ask again

:
:

oc
L
L
o
e
<
S

[ ok || cancel |

13. Exiting the program DOES NOT turn off the 3.5G module, and you will need to
press the Fn + [3 key combination to turn off the module (pay careful attention to
this aboard aircraft - see “Wireless Device Operation Aboard Aircraft” on
page 7 - 20).

14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

» If the 3.5G module is on and the computer is Shut Down or Restarted; the
module will be off when the computer starts up.

 If the 3.5G module is on and the computer enters Sleep or Hibernate; the mod-
ule will be off when the computer resumes from sleep.

. |
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Short Messaging Service

In addition to standard internet services you may also send and receive SMS text
messages using the 3G Watcher program, if your service supports SMS.

Reading SMS Messages

1.

wn

The SMS message indicator & in the main window will notify you of any new
messages received.

Double-click the icon g or select Tools > SMS Express.

Select the inbox folder and select any message to read it.

You cannot receive any new messages if the USIM card becomes full so you will
need to delete some of the messages in order to fee up space on the USIM card.

Creating and Sending SMS Messages

Double-click the icon g or select Tools > SMS Express.

Select File > New Message or click the New button.

Enter the recipient’s number in the To.. field or click the To.. button to select an
entry from the phone book, and click the Message button.

Type in the message details in the message body area.

Click the Send button (or save the message to send later).

For more details on SMS see 3GWatcher Online Help from the Help > Help Top-
ics menu.
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Fingerprint Reader Module

If you have included the (optional for Models C - E only) fingerprint reader in your
purchase option you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 4.FingerPrint > Yes.

Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.

ook wN

.|
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4

Help & Manual

Right-click the taskbar icon
[ to bring up the menu to
select Help.

Insert the Device Drivers &
Utilities + User's Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click
4.FingerPrint >Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User's Man-
ual disc and click User's
Manual (button), and click
Install Acrobat Reader
(button).
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User Enrollment

1. Click Start > Programs/All Programs > Protector Suite QL > User Enroliment,
or double click the taskbar icon [E].

2. On the first run of the program you will be asked to click the button to accept the
license, and then click OK.

3. Click Next and select “Enrollment to the hard disk”, and click Finish.

Finish =

- 5|

Figure 7 - 25
Enroll to Hard Disk

7 & Eruoiment ko the hard dsk]
Al firgerprnks ave stored on your hard drive and encryted by software., Users can evol
arry number of ingerpants.

< fack Frmh Carked

A Fragers are ervolied deectly b the seraor, Your user datn can be seased by hardware
aratecied keys chusned fom the fngerprnt sensor, Ths mode sikws only 21 fngenorrits

4. If you have not set a Windows password you will be prompted to do so (note: If
you have not set a password Protector Suite QL cannot secure access to your

computer).
5. Click Next.
6. You will then be prompted to enter your Windows password.

7. Click Next > Next (if you have the “Run interactive tutorial” tickbox selected you
will run through the Fingerprint Tutorial).

8. Click Next for each window of the tutorial (you can click the button to “skip
tutorial” at any time).

.|
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9. Click the button above any of the fingers to begin the enroliment process for that

finger. ﬁ
10. Swipe the finger three times to enroll that finger.

11. Repeat the process for all the fingers you wish to enroll (see sidebar), and then Fingerprint
click Next. Enrollment
12. Click Finish.

13. Click any of the headings under “Learn more about:” to get more information on

Note that it is strongly rec-
ommended that you enroll

any topic. more than one finger in
14. Click Close. case of injury etc.
User's Fingers ,,.l
o S T e o Vb e LR RS (i Protector Suite QL Introduction
= Srosmees lnoon pnd umr ptcheg
- -
:mm“h Swipe your finger to display the Flgure 7 _ 26
- R Fingerprint
«Tlegeter and replay lagon nfy
e s Enrollment
« Ervoll and manage fingerprint aptons
Vs it ALK, [Com ]
<Back [ next> | [ cancel
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15.

Figure 7 - 27
Control Center &
Biomenu

Right-click the taskbar icon [ to bring up the menu that allows you to Edit
Fingerprints, Start Control Center, access the Help menu etc. You can also run
the Control Center etc. from the Protector Suite QL item in the Programs/All

Programs menu.

Fingerprint Control Center

@ about

(® Fingerprints
Enroll or edit current user's fingerprint templates.

(® Settings
Configure the fingerprint software.

® Help

Get help information.

@ Introduction
@ Tutorial
< Help

© Elevate administrative privileges for user
When do | need to do this?

16.
17.

18.

See “Help & Manual” on page 7 - 27 for further details.

If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, open the Control Center and access
the Help menu.

The Control Center allows you to change the Settings, enroll Fingerprints and
get Help.

.|
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 11) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).

.|
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)” on page 5 -
2).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

\ A/
L&
Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.

Backup and General Maintenance 8 - 3
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Viruses

Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).

8 - 4 Viruses
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Upgrading and Adding New Hardware/Software

» Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

.|
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» Thoroughly check any recent changes you made to your system as these changes may affect one or more

system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator ¢ i, is | Low Battery. Plug in the DC power source. If the computer doesn't start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4/“Power Schemes” on page E - 20) check
its settings. You may also be using an ExpressCard/USB device/external device
that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 10/“Battery Information” on page E - 25).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn
off/remove the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 19). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8/
“Sleep Button” on page E - 24).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix B/Appendix C/“Video Features” on page E -7
on. for instructions on installing and configuring the video driver.

. |
8 - 8 Problems and Possible Solutions



Troubleshooting

Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
I

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 15) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5/“DVD Regional Codes” on page E - 2.

Unwelcome numbers when

typing.

appear

If the LED IEI is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 11).
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Problem Possible Cause - Solution

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

The system freezes or the screen goes | The system’s power saving features have timed-out. Use the AC/DC adapter,
dark. press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power | Power Options features are not enabled. Go to the Windows Power Options
saving mode. menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6/“System Power Options” on page E - 22). Make sure you have
enabled Hibernate mode from the control panel.

The Wireless LAN/Bluetooth/3.5G | The modules are off. Check the LED indicator (‘1’} and/or function key indicator
modules cannot be detected. to see if the WLAN/Bluetooth/3.5G module is on or off (see “LED Indicators”
on page 1 - 11). If the LED indicator is off, then press the Fn + F11 (WLAN), Fn
+ F12 (Bluetooth) or Fn + [£] (3.5G) key combination(s) in order to enable the
modules (see “- Function & Hot Key Indicators” on page 1 - 15).

. |
8 - 10 Problems and Possible Solutions



Troubleshooting

Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on pagel - 15). Run the
BisonCap program to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Cameral/3.5G modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1/*Module Drivers”
on page E - 33).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.
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Problem Possible Cause - Solution

The Hibernate function has disappeared. You have a computer with 4GB of RAM and have installed Windows Vista Serv-
ice Pack 1. This is a known issue if your computer has 4GB of RAM and is run-
ning Windows Vista Service Pack 1. To re-enable Hibernate mode go to the
Command Prompt and type the command “powercfg -h on” (make sure you
are logged on as an Administrator):

1. Click Start & (menu button).

2. Type “cmd” in the Start Search box [k 2].

3. Double click the Command Prompt Ecmd when it appears in the
menu.

4. Type “powercfg -h on” in the Command Prompt window.

5. Close the Command Prompt window.

6. The Hibernate function will now be enabled.

. |
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Screen Resolution Error

If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with
Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is
closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is
opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen
resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

O@v | » Comtrol Paned

Calor

Indsing  Iotemet  SCHInitator  Keyboard se  Networkand  NVIDIA
Options  Options Sharing Ce.  Contr..

PE/ Yy S

Offime Files  Parerdal Penand  Prople New Peformance Perensks..  Phore n
Controls  Input Devices Me Informatio.. Modem .

LU L1 Fa N LS

Figure 8 - 1 - Control Panel System and Maintenance
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3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

T et =]

File Action View Help

2 i Name Status  Triggers Next Run Time  Last Run Time Last Run Result Autho| |Actions
7% Task Scheduler Library : ‘ e N
2 B Wikt @ Hotstart Ready  Atlog on of any user 1/9/2007 532:21 PM _ The operation completed successfully, (0:0) Micro
= Windows Running At log on of any user PB The task is currently minning, (x41301) I | B Creste Basic Task..

% Create Task...

> Import Task...

[ Display All Running Tasks

| CertificateServicesClient
7 Customer Experience Improv
71 Defrag

1 DiskDiagnostic Properties 9 NewFolder..
. - Delete X Delete Folder
1 Multimedia |6 Refresh

= gl i | ;
] NetworkAccessProtection

@ Hel
General | Triggers | Actions | Conditiens | Settings | History | LB

< RAC Selected ltem -
J RemoteAssistance Name: TMM B Run
1 shel Author: Microsoft Corporation a End
1 SideShow
™ SyncCenter Description: Microsoft Transient Multi-Monitor Manager ¥ Disable
1 SystemRestore Export...
L Tepip
| TextServicesFramework B ipmrens
= Delets
. Security options X Delete
= wot Help
(] Windows Error Reporting When running the task, use the following user account:
I WisdausCaleridar Authenticated Users
1 Wired
=1 Wireless Run only when user is logged on

| Windows Defender )
Run whether user is logged on or not

Do not store password. The task will only have access to local resources

| Run with highest privileges

Figure 8 - 2 - TMM Disable
6. Close all the control panels.
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Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Interface (Ports & Jacks) A- 1
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Notebook Ports and Jacks

Item

Description

Card Reader Port

O

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA)

D-U
(=}
=3

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

Headphone-Out Jack

O

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack

%,

Plug an external microphone in to this jack to record on your computer.

RJ-11 Modem Jack

LA

This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
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Item Description

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

B

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

:

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

;

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

$
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Appendix B: SIS Video Driver Controls

The basic settings for configuring the LCD are outlined in “Windows Vista Start
Menu & Control Panel” on page 1 - 21.

SIS Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers
(button).

Video

1. Click 1.Install Video Driver > Yes.

2. Click Yes (click Yes if you want to view the ReadMe file).
3. Click Yes to restart the computer.

Note: After installing the video driver go to the Display Settings control panel to
adjust the video settings to the highest resolution.

Video Memory

The system does not feature dedicated video memory, but automatically and dynam-
ically allocates as much (up to 256MB maximum) system memory (RAM) as need-
ed to the video system. The system returns whatever memory is no longer needed to
the operating system.

SIS Video Driver Installation B - 1

4

Function Key
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

» Notebook Only

» External Display
Only

» Notebook + External
Display

Make sure you give the

displays enough time

to refresh.



SIS VGA Control Center

More advanced video configuration options are provided by the SIS VGA Control
Center.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click SiS VGA Control Center (click “Classic View” from the left of the
menu if you are in Control Panel Home).
OR
3. RIght-click the SIS Tray taskbar icon [, and select Control Center.

FigureB -1
SIS VGA Control
Center

B - 2 SIS VGA Control Center



You may make changes to the video and display settings by clicking the appropriate
menu button.

Devioa Lict =Chinge Deyeses

=
=
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Figure B - 2
SIS VGA Control
Center Control

Panels

SIS VGA
105120 18 VGA Kool
105120 SiSToay 0

SIS VGA Control Center B - 3



Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT) or ex-
ternal Flat Panel Display as your display device. A VGA monitor/Flat Panel Dis-
play connects to the external monitor port. The following display modes are

available.
Display Setting Mode Description
Single | oy j| One of the connected displays is used as the display device
Table B - 1 - Both d displ h iew and may b
. —== oth connected displays output the same view and may be
Display Modes Clone [“’ = configured independently
Both connected displays are treated as separate devices, may be
Multi-Mode E] configured independently and act as a virtual desktop (this is
similar to Extended Desktop in Windows)

. |
B - 4 SIS VGA Control Center



Attaching Other Displays

Besides the built-in LCD, you can also use an external monitor (CRT)/flat panel dis-
play as your display device. Connect it to the external monitor port on the left of the

computer, and configure the displays from SiS VGA Control Center:

1. Attach your external display to the external monitor port and turn it on.

2. Click Start, and click Control Panel (or point to Settings and click Control Panel).

3. Click SiS VGA Control Center (or click Appearance and Personaliz
VGA Control Center).

ation > SiS

4. Click Display Setting icon .
5. Click Device List <Change Devices>.
6. Select which active device is to be Device 1/Device 2 and click OK. .
FigureB-3
2 Click OK to close the window if you decide Select Active
s Dot not to change display devices (do not use Devices
il Alt + F4 to close the window).
7. You can then choose the Display Setting mode from the menu buttons.
Figure B - 4

Display Setting
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To Enable a Display Setting Mode

1. Attach your external display to the external monitor port and turn it on.
2. Gotothe SiS VGA Control Center > Display Setting menu .

3. Click the appropriate icon for the display setting mode you wish to use.
4. Click Yes within 15 seconds in order to save the setting change.

Figure B-5
Confirm Changes Do you want to keep this change?

15 seconds

5.  You can adjust the display modé, change the status and clone Device 1 from
the device list menu.
6. Click Apply > Yes to save any changes.

i TR

=% AT
fesiizis  Multi-Mode

B Figure B - 6 = =: =5

I et it

Display Setting
Device List Options

B - 6 To Enable a Display Setting Mode



Using Display Settings to Enable Extended Mode

1. Attach your external display to the external monitor port, and turn it on.
2. Open the Display Settings control panel (see “Windows Vista Start Menu &

Control Panel” on page 1 - 21).

3. Click the monitor icon (e.g. B), and make sure you have checked “Extend the
desktop onto this monitor.” and click Apply.

K Display Settings

Manitor |

s

Drag the icons to match your menitors,

\

1 =B

N

‘ Identify Monitors ‘

N\

p

|

1024 by 768 pixels

How do [ get the best display?

Colors:

[J High

| Advanced Settings... ‘

[ Highest (32 bit)

= |

ok | | Cancel

Apply ]

To Enable a Display Setting Mode B - 7

Click the appropriate monitor icon
(e.g. B) to be able to select the op-
tion to extend the desktop on to it.

" In this example the Primary Display
is on the left, the Secondary Dis-
play B is on the right.

4

Display Settings
Extended Desktop

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

FigureB-7
Display Properties
(Extended Desktop)






NVIDIA Video Driver Controls

Appendix C: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Windows Vista Start
Menu & Control Panel” on page 1 - 21. _ZX_

Y/

\Y

NVIDIA Video Driver Installation RESOIHION EHOr

. . . .. A If you are experiencing
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. RS St el

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers lems/screen flickering after

(button). resuming from Sleep in
Windows Vista see page

1. Click 1.Install Video Driver > Yes.

2. Click Next.

3. Click Finish to restart the computer.

Note: After installing the video driver go to the Display Settings control panel to
adjust the video settings to the highest resolution.

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-
es. Check with your service center for the latest details on video cards supported.

NVIDIA Video Driver Installation C - 1




NVIDIA Video Driver Controls
NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click “Classic View” from the left of the menu
if you are in Control Panel Home).
OR

3. RIght-click the desktop.
4. Click NVIDIA Control Panel.

WView 3
Sort By b
FigureC-1 Refresh
NVIDIA Control g 0T N | T e D s AR
Panel Paste Shortcut Tt

.....

MVIDIA Control Panel

Nm ' : o ' ‘I inng '

B, Personalize

ing Fies  Parental Pen and
Controls  Input Devices

Peopi Hear
e

. -

C - 2 NVIDIA Control Panel



The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc.

v it

| St

NVIDIA Video Driver Controls

4

Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

FigureC -2
NVIDIA Control
Panels

NVIDIA Control Panel C - 3
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

[<AnviDIA.

Condiol Panel

T | WVIDIA Control Panel

FigureC -3
Help Menus

C - 4 NVIDIA Control Panel
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Attaching Other Displays

Configuring an External Display in Windows Vista

1. Attach your external display to the external monitor port and turn it on.

2. If a New Display Detected window does not appear in Windows Vista, go to the
Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

l) e Deplay Detexted

brightness

Brightness Volume Battery Status Wireless Network . .

Display No syne : | ¢ Duplct o Akt o o dlags (]
connected partnerships @& Not presenting | .

Display '\<.‘ 5 Fully charged il Choorse the appearance of your display
i M {100%) q!m Connected

(" Connect display Syncsettings | | | Turn on

External Display Sync Center Presentation Settings

Attaching Other Displays C - 5

4

Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The fol-
lowing are the display
options:

The built-in LCD.

An external monitor
connected to the
external monitor port.
A flat panel display
connected to the
external monitor port.

Figure C - 4
New Display
Detected
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Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.

1. Attach your external display to the external monitor port and turn it on.
2. Goto NVIDIA Control Panel (see “NVIDIA Control Panel” on page B - 2).
3. Click Set up multiple displays (Display).

Fle f[da Yuww Peohies Dupley Help
(] - | [E aseanced settings =
: |3 Set Up Multiple Displays

%
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Bttt st ok
wtirgs
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goH

-
FigureC-5 — =t
Set Up Multiple © e
Displays P

Reverting in 7 seconds

O
e ol shiew e e Fage o s ffererd dietars. (ot o tlore. Wik sews by 4 g iy |

T mage weeraren

& Svwtem budarmatinn @ — |

Click to select the nView display mode you wish to use (see page C - 7).

Select the display(s) you want to use (if your display is not shown click “My Display
is not shown in the list...”), and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.

o &
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NVIDIA Video Driver Controls

Display Modes

Single Display Mode
Only one of your displays is used.

SN
L&

Resolution Error

If you are experiencing

Clone Mode screen resolution  prob-
Clone Mode simply shows an exact copy of the Primary display desktop on the other E?jﬁf;:e?:ﬂeg?fezni
display(s). This mode will drive multiple displays with the same content. Windows Vista see page

Dualview Mode

Dualview Mode treats both connected displays as separate devices, and they act as
a virtual desktop resulting in a large workspace. When Dualview is enabled, you can
drag any icons or windows across to the other display desktop. It is therefore possi-
ble to have one program visible in one of the displays, and a different program visi-
ble in the other display.

Display Modes C - 7




NVIDIA Video Driver Controls

Using New Display Detected to Enable Extended Mode

1. Attach your external display to the external monitor port and turn it on.

2. If a New Display Detected window does not appear in Windows Vista, go to the
Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

Click to select Show different parts of my desktop on each display (extended).
Click Right or Left under Extend your desktop.

Click Apply > OK.

arw

,_# Mew Display Detected

Choose the appearance of your display

Figure C -6
. Extend your desktop:
New Display © Right
Detected
(Extended)

() Duplicate my deskto mirrored)

@ Show different parts of my desktop on each display (extended);

() Show my desktop on Ihe exemal display only

To select different settings, go to Display Settings in Control Panel.

Apply 0K

C - 8 Display Modes



NVIDIA Video Driver Controls

Using Display Settings to Enable Extended Mode
Attach your external display to the external monitor port and turn it on.

1.
2.

3.

Click Start, and click Control Panel (or point to Settings and click Control

Panel).

Click Adjust screen resolution under the Appearance and Personalization

menu (or double-click Personalization > Display Settings).

Click the monitor icon (e.g. B), and make sure you have checked “Extend the

desktop onto this monitor.” and click Apply.

Moritor |

Drag the icons to match your monitors,

| Sedw

| Identify Monitors |

2. (Default Monitor) on NVIDIA GeForce 9300M GS

| This js oy main,
|

L
& /| Extend the desktop onto this MDD

Resolution:
Low [J High

1024 by 768 pixels

Colors:
[H.ghest G2bi)  ~|

How do [ get the best display? | Advanced Settings...

OK H Cancel H Apply I

Click the appropriate monitor
icon (e.g. A) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor @ is on the left, the secondary
display B is on the right.

4

Display Settings
Extended Desktop

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

FigureC -7
Display Settings
(Extend the
Desktop)

Display Modes C - 9
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Specifications

Appendix D: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check
with your service center for details.

.|
Specifications D - 1



Specifications

Feature Specification

Processor Intel® Core™2 Duo Processor 45nm (45 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, Socket P 3MB On-die L2 Cache & 800MHz FSB - TDP 35W
T8100/ T8300 2.1/ 2.4 GHz
Intel® Core™2 Duo Processor 45nm (45 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, Socket P 6MB On-die L2 Cache & 800MHz FSB - TDP 35W
T9300/ T9500 2.5/2.6 GHz
Intel® Core™2 Duo Processor 65nm (65 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, Socket P 2MB On-die L2 Cache & 800MHz FSB - TDP 35W
T7100/ T7250 1.80/ 2.0 GHz
Intel® Core™2 Duo Processor 65nm (65 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package, Socket P 4MB On-die L2 Cache & 800MHz FSB - TDP 35W
T7300/ T7500/ T7700/ T7800 2.0/ 2.2/ 2.4/ 2.6 GHz
Intel® Celeron® M Processor 65nm (65 Nanometer) Process Technology
(478-pin) Micro-FCPGA Package, Socket P 1MB On-die L2 Cache & 533MHz FSB - TDP 31W
560/ 570 2.13/2.26 GHz

Core Logic Models A, B & E: Models C. D & F:
SiS M672 + SiS968 Chipset SiS 671DX + SiS968 Chipset

D - 2 Specifications



Specifications

Feature

Specification

LCD

Models A & C:

14.1" WXGA/ WXGA+ Glare Type TFT LCD

Models B & D:

15.4" WXGA/ WXGA+ WSXGA+ Glare Type TFT
LCD

Model E:

17" WXGA (1440 * 900) TFT LCD

Model F:
17." WXGA (1440 * 900) / WSXGA+ (1680 * 1050)
/ WUXGA (1920 * 1200) TFT LCD

Video Adapter

Models A.B & E:

SIS® M672 Integrated Video

High Preference 3D/2D Graphic Accelerator
Shared Memory Architecture (up to 256MB
dynamically allocated from system memory where
needed)

Supports DirectX 9.0

Supports Vertex Shader 2.0 and Pixel Shader 2.0

Models C.D & F:

nVIDIA GeForce 9300M GS Discrete Graphics
On-Board

256MB of GDDR2 Video Memory On-Board
TurboCache™ Supporting Total Graphics Memory
up to 512MB (depending on system memory)
Supports DirectX 10.0

Supports HDCP

Memory 64-bit Wide DDRII (DDR2) Data Channel
Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 667MHz
Memory Expandable up to 4GB (1024MB/ 2048MB DDRII Modules)

Security Security (Kensington® Type) Lock Slot BIOS Password
Fingerprint ID Reader Module (Factory Option)

BIOS One 8Mb SPI Flash ROM Phoenix™ BIOS

Specifications D - 3




Specifications

Feature Specification

Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page D - 7) Easy
Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD

Audio High Definition Audio (HDA) S/PDIF Digital Output
3D Stereo Enhanced Sound System 2 * Built-In Speakers
Sound-Blaster PRO™ Compatible Built-In Microphone

Keyboard Models A - D: Models E & F:
WinKey Keyboard (with embedded numeric Full Size WinKey Keyboard (with numeric keypad)
keypad)

Pointing Device Built-In TouchPad with Scrolling Function

Interface Three USB 2.0 Ports One RJ-11 Modem Jack
One Headphone-Out Jack One RJ-45 LAN Jack
One Microphone-In Jack One DC-In Jack
One S/PDIF-Out Jack One External Monitor Port

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo) Note: MS Duo/

Mini SD/ RS MMC Cards require a PC adapter

Card Slots One ExpressCard/34(54) Slot Two Mini-Card Slots with USB interface:

Slot 1 for WLAN Module
Slot 2 for 3.5G Module (Factory Option)

D - 4 Specifications



Specifications

Feature Specification

Communication 56K Fax Modem
Built-In 10M/100Mb Base-TX Ethernet LAN

ﬁ 802.11b/g Wireless LAN Mini-Card Module with USB interface (Option)

= 1.3M or 2.0M Pixel USB PC Camera Module (Factory Option)

UMTS Modes

Note that UMTS Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)

modes  CAN [MSS

NORF TGl 3.5G Module:

North America. UMTS/HSPDA-based 3.5G Module with Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

Power Supports ACPI 3.0 Supports Wake on USB
Management Supports Wake on LAN Supports Resume from Modem Ring
Power Models A. B & E: Models C.D & F:

Full Range AC/DC Adapter AC input 100 - 240V, Full Range AC/DC Adapter AC input 100 - 240V,
50 - 60Hz, DC Output 19V, 3.42A OR 18.5V, 3.5A | 50 - 60Hz, DC Output 19V, 4.74A (90 Watts)
(65 Watts)

6 Cell Smart Lithium-lon Battery Pack, 4000mAH OR 4400mAH

9 Cell Smart Lithium-lon Battery Pack, 7200mAH (Option)
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Specifications

Feature Specification
Operating Windows® Vista (with Service Pack 1)
Systems Windows® XP (with Service Pack 3)
Supported
Environmental Temperature Relative Humidity
Spec Operating: 5°C - 35°C Operating: 20% - 80%
Non-Operating: -20°C - 60°C Non-Operating: 10% - 90%
Dimensions Models A & C: Models B & D:
& Weight
336mm (w) * 250mm (d) * 24.8-35.7mm (h) 359mm (w) * 268mm (d) * 24.8-37mm (h)
2.2 kg With 6 Cell Battery & ODD 2.5 kg With 6 Cell Battery & ODD
Models E & F:
397.2mm (w) * 282.5mm (d) * 39.5mm (h)
2.9 kg With 6 Cell Battery & ODD

.|
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Specifications

Feature

Specification

Optional

Optical Drive Module Options:
DVD-ROM/CD-RW Combo Drive Module

DVD Dual (Super Multi) Drive Module

802.11b/g Wireless LAN Mini-Card Module with
USB interface

9 Cell Smart Lithium-lon Battery Pack, 7200mAH

1.3M or 2.0M Pixel USB PC Camera Module
(Factory Option)

Fingerprint ID Reader Module (Factory Option
for Models C - F)

Bluetooth 2.0 + EDR (Enhanced Data Rate)
Module (Factory Option)
OR
UMTS/HSPDA-based 3.5G Module with Mini-Card
Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900 MHz,
1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)

AN
I

UMTS Modes

Note that UMTS modes CAN NOT be used in
North America.

Specifications D - 7
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Appendix E: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows XP OS.

E-1



DVD Regional Codes

4

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives.

Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control
panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

Region Geographical Location )
Genecsl | Propaies | DVD Fiegion | Veluras | Diier
1 USA, Canada Lt e o il AT ¢ TS
B ;
2 Western Europe, Japan, South Africa, Middle East & Egypt CAITION Yoo change b g a e st o v
i‘y‘;lemnlWrMawm):-lmm vt 5 ATare ConAtn,
3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong i i
Ta changs the cunent iegon, select & gecoiaphic aes. and then clck OF.
a South & Central America, Mexico, Australia, T e ——
New Zealand Uit han
E;::-:Itl‘;r
5 N Korea, Russia, Eastern Europe, India & Most of Africa Cunent Plegon: [N Seimemd
Hew Regon:  [Fiagon 1
6 China o Carenl
Table E - 1 - DVD Region Codes Figure E - 1 - DVD Regions

=
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Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

T B it ek
— U] 5o Progrem Acoess end Defiuks

Open All Users
Explore All Users

& Hstwarh, Corrmclions
S Frinters and Ficcms.

il Tashbar and Start Merw

Click here to toggle Category View

Figure E - 2 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

. |
Windows XP Start Menu & Control Panel E - 3




TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one

of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page E - 32) you can configure the functions
by double-clicking the TouchPad driver icon £ on the taskbar. You may then configure the TouchPad tapping,
buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information

at www.synaptics.com.

4

Mouse Driver

If you are using an external mouse
your operating system may be able to
auto-configure your mouse during its
installation or only enable its basic
functions. Be sure to check the de-
vice’s user documentation for details.

Mouse Properties

Buttons | Painters | Pointer Options | wheel | Hdware | B] Device Settings

Button configuration
Devices

& Righthandsd © Lefthanded
Left Right

~Prirnaty Click [Normal Select, - Secondary Click [Contest
Kormal Drag) Menu, Spevial Diag)

Double Click Speed

Double-click the folder to test your setting. I the folder does not

apen of close, iy using & slower setfing. o
Slow Fast &=

ClickLock

[~ Tum on ClickLock

Enables you to highlight or drag without halding dawn the mause butten. Taset,
riefly press the mause bulton. To release, click the meuse button again.

umm Sers | Fomter Uptons | Whes! = | [ Device Setings

Synaptics Pointing Device - +3.0.2 120ct06

Deyices:
Enabled | Wame Port
Ves Synaplics 1 ouchPad V6.3 5/

S—
Tray lcon
 Remove tray icon from taskbar 420FM
" Static tray ican in taskbar @) azo0PM

= Arimated tray icon i taskbar

BT 4z0PM

v spnaphics com

Figure E - 3 - Mouse Properties
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Function Keys/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed (see

“Hot Key” on page E - 32). When the driver is installed, an icon & will appear in the taskbar.

et ]

Keys Function Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn+F7 Display Toggle
Fn+ E 3.5G Module Power Toggle Q Q Fn + F8/F9 Brightness Decrease/Increase | e ¥
@ rewerem @ Poweren | ’ OO A
Fn+F1 TouchPad Toggle @ @ Fn + F10 PC Camera Power Toggle 1,1 ]
— — - : - | © toeran 7 @ Pemerol
Turn LCD Backlight Off {9)) (Y]
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+FL1 WLAN Module Power Toggle (1) 1
) @ Radicoff
Fn+F3 Mute Toggle | Q Fn + F12 Bluetooth Module Power Toggle .
Volume ®  Ohn Volume *  Mute O Teeron @ Pewrall
Fn + F4 Sleep Toggle (@ *Silent Mode Toggle Norrmna;!ie@ Sih;:ndc
» ’ . )
En + F5/F6 Volume Decrease/increase | 'When enabled, Silent Mode will reduce fan noise and save power

consumption. Note this may reduce computer performance.

Table E - 2 - Hot Key Functions & Indicators
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Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices ®, Windows con-
trol panel, or from the Realtek HD Audio Manager [ icon in the taskbar/control panel (this will bring up the
Realtek Audio Configuration menus). The volume may also be adjusted by means of the Fn + F5/F6 key com-
bination.

4

Sound Volume Adjustment

Environment <Mone»

How high the sound volume can be
set depends on the setting of the vol-
ume control within Windows (and the
volume control function keys on the
computer). Click the Volume icon on
the taskbar to check the setting.

Figure E - 4 - Realtek Audio Configuration Menus
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Video Features

This computer features two different (either SiS for Model A, B & E computers or NVIDIA for Models C, D
& F computers) video options. You can switch display devices, and configure display options, from the Display
Properties control panel in Windows as long as the appropriate video driver is installed. For further information
see either ““SiS Video Driver Controls” on page E - 9 (pages E - 9 to E - 12) or “NVIDIA Video Driver Con-
trols” on page E - 13 (pages E - 13 to E - 16). Note: After installing the video driver go to the Display Proper-
ties control panel to adjust the video settings to the highest resolution.

To access Display Properties in Windows:

Click Start, point to Settings and click Control Panel (or click Control Panel).

Double-click Display (icon); Display (icon) is in the Appearances and Themes category.

Click Settings (tab) in the Display Properties dialog box.

Move the slider to the preferred setting in Screen resolution (@ Figure E - 5 on page E - 8).

Click the arrow, and scroll to the preferred setting in Color quality (@ Figure E - 5 on page E - 8).

Open the Display Properties control panel, and click Advanced (button) @ to bring up the Advanced
properties tabs.

To access the SiS Utility Manager (Models A, B & E):

1. Select Advanced properties (see above), click SIS Utility Manager (tab) to access the SIS video controls.

2. You can also access SIS video controls by right-clicking the SIS Utility Tray taskbar icon , and selecting the
appropriate control from the Display Property(D) menu.

To access the NVIDIA Control Center (Models C, D & F):
1. The NVIDIA Control Panel can be accessed by right-clicking the desktop, and then clicking NVIDIA Control
Panel (or from the NVIDIA Control Panel in the Windows control panel).

ok wnpE
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Display Properties & SiS Utility Manager/NVIDIA Control Panel

Plug and Play Monitor and $i5 Mirage 3 Graphics Properties  [? |5

Display Propertics

T | Dechivg | Scrmen e | Apmatance | Seinge |

Dirag the moritor ikons to metch e physicsl attangement of your monior.

F‘:Driver Mode Settings(I)

gDesktop Gamma CorrectionfE)
B video Setting ()

_l_‘fProduct and File Information(F)

Risplay:
11 Phig 2rd Play Bloritior on 55 Misage 3 Graphics ~
eresn rehution Cokor quakily

i Jn”“ Hughest 32 1] gv | i
e = Right-click taskbar icon m

il ~ Right-click desktop
. Co o]

Display Properties

Arrange Icons By L4 =

Themes | Dnskinp | Sereen Saves | Appemancn | Settnt | D[ et

Refiesh CI T —

| .
A e ] ) s e o e o 1 i,

Dhaang thre rvorston wconiz b maslch the phywcal seangement of your neslo.

sl |
1 BIDEA s crcam - 1
Soipen resghation Cokor qualty I
Leex Mot Haghvest 37 b ﬁ Mew r I :H‘
1a0ke [ B | -

Gl it e i v Properties |
_Kh& Tioutdeshoul... o i

Figure E - 5 - Display Properties & Video Control Panels
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SiS Video Driver Controls

(Models A, B & E)
Access the SiS Utility Manager as indicated on page E - 7. You may make changes
to the video and display settings by clicking the appropriate menu button.

Driver Mode Selling

R0 | Eole Cabraten|

L |
Display devices detecton |
Suggent Modes. r
LD =
12780 by 500 postn. True Cokon (32 be] 60 Hz =| L
[ = | i 100
e
Praduct and 1iln Infermation E '_I:!
[Frocici} Fie |

Vi Corichs |
lhem | Content
Tompary Gl Irbagrstad il Conporion |
Produt SEBET2 series —— [
Graphes Engine Mrsge e Hum J
St Virian 383
D Vv 38 Ssen |———————— [Tom
Hemcnisae] 1200 HDves

BISIDEM Producfle) 17210
Vidoo Brdge Chp Tpe SI5307 senes | Drightnes: ]
" % i ———F———

]

‘ Cise I [ ] cocel | Desas

SiS Video Driver Controls E - 9

4

Function Key
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

* Notebook Only

» External Display
Only

» Notebook + External
Display

Make sure you give the
displays enough time
to refresh.

Figure E - 6
SIS Utility Manager
Control Panels



Display Devices & Modes (SiS)

Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display
as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port. The following
display modes are available.

Driver Mode Setting Description
Single One of the connected displays is used as the display device
Clone E Both connected displays output the same view
Both connected displays are treated as separate devices, may be configured
Multi-Mode E i?v?r?dpgcvdsmly and act as a virtual desktop (this is similar to Extended Desktop in

Table E - 3 - Display Modes

E - 10 SiS Video Driver Controls



Attaching Other Displays (SiS)

If you prefer to use a monitor or flat panel display as your display device, then con- 4
nect it to the external monitor port on the left of the computer. Secondary Device
1. Attach your external display to the external monitor port, and turn it on. Click to put a tick in the
2. Go to the SIS Utility Manager control panel and click Driver Mode Settings. Power on secondary
3. Click to choose the Primary or Secondary display option from the menu. de:jnce (tjn.oxlﬁ ”:je sec’;
4. Click the button to toggle either Clone B or Multi-Mode Ez. Zn ‘;g ISplay doesn
5. Click OK > Ok > Yes to confirm the settings change. ppear.
Driver Mode Setting |E|E| Driver Mode Setting ‘gl
i Diriver Mode ~Diiver Mode
Frimary Secondary Frirnary Secondary
i ﬂ FigureE -7
- — o Driver Mode
= - - Settin
LD - g |cRT > JJ g
¥ Power on secondary device ¥ Power on secondary device
Display devices detection Display devices detection
Support Modes Support Modes
CRT CRT
| 1024 by 768 pivels, True Color (32 bits), B0 Hz ~| | 1024 by 768 pixels, True Color (32 bits), 60 Hz ~|
[ LCD
ol [32 bils), GO H =l | 1024 by 768 pisels, True Color (32 tits), 60 Hz |
()4 | Cancel ‘ oK ‘ Cancel ‘

SiS Video Driver Controls E - 11



To Enable Extended Desktop (Windows Display Properties)

1.
2.

3.
4,
5

Attach your external monitor to the external monitor port, and turn it on.
Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View

choose Appearance and Themes).

Double-click Display (icon).

In the Display Properties dialog box, click Settings (tab).

Click the monitor icon (e.g. B), and make sure you have checked “Extend my Windows desktop onto this

monitor.” and click Apply.

Display Properties

Themes | Desklop | Screen Saver | Apnearamcel Settings |

S

[Dirag the manitor icons to match the physical arangement of paur monitars

12

Display.

i 2. Plug and Play Monitar on 5i5 Mirage 3 Graphics W |
Screen resolulion Color quality
bt —] Mare [ Highest (32 bi ~

I/ .

1024 by 7EB pixels

m TIE o
Extend my Windows desktop onto this monitor,

[ |dentify ][ Troubleshoot... ] [ Advanced ]

[ Ok ][ Cancel ][ Lpply

Click the appropriate mon-
itor icon (e.g. B) to be able

| to select the option to ex-

tend the desktop on to it.

In this example the Primary
monitor |@ is on the left, the
secondary display B is on
the right.

4

Display Settings Extended
Desktop

Use the control panel to drag the mon-
itors to match the physical arrange-
ment you wish to use.

You can drag any icons or windows
across to either display desktop,
which makes it possible to have one
program visible in one of the displays,
and a different program visible in the
other display.

Figure E - 8 - Display Properties (Extended Desktop)
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NVIDIA Video Driver Controls

(ModelsC,D & F)

Access the NVIDIA Control Panel as indicated on page E - 7. You may make
changes to the video and display settings by clicking the appropriate menu item.

[P —————

[Ty Manage Custom Reselutions e |

4

Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the headings,
menus and highlighted

links for information.
Use the buttons on the
top left to go back, for-
ward etc.

The Help menus pro-
vide index and search
features, and direct
links to the NVIDIA
website etc.

Figure E-9
NVIDIA Control
Panels
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Display Devices and Modes (NVIDIA)

Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display
as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port. The following
display modes are available.

nView Display Mode Description
Single One of the connected displays is used as the display device
Clone Both connected displays output the same view

Both connected displays are treated as separate devices, may be configured
Dualview independently and act as a virtual desktop (this is similar to Extended Desktop in
Windows)

Table E - 4 - Display Modes
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Attaching Other Displays (NVIDIA)

1.
2.
3.

>

Attach your external display to the external monitor port and turn it on (see sidebar).

Go to the NVIDIA Control Panel.

Click Display, and then click Set Up Multiple Displays.

E"Ej Set Up Multiple Displays

DA p
perlect I a luger dezkiop

1. Choose the niview display mode to use,
{2 Onky s e chsplay (Jngle)
() Thon e e Bt el ()
() Confgured Indegondently from ach other (Dyshiew)

2. Sclect the displays you would be to use.

. (8 Lo Disedar + Sarmges Trchs. PE-TOFAY v
4\_!!’ ‘Samess Tach, FO-T0FAL + Laptoe Dispiay
- o G-+ S0 Tach. #0-10PM

g0 Criglry + S0 Tech. P JTFAL
P dsplay is not shown inthe k...

Rtrean A ctbar Spitat Siraded o0

...... = ,ﬂ
Selocts the duplry that Windows wil use as the primary dsf

ine ikl condigue tion s changed.
Weakd yim B L hees therie changes?

(= )

Rrverting i 10 seconds

ot
o Wheer yous Weioows Start Euttio e diblcq kosrm aem displaysed

& Sotenlolamation

=

Choose the nView display mode you wish to use.

Select the displays you want to use (if your display is not shown click “My Display
is not shown in the list...”), and choose which display is to be the primary display.

Click Apply make the change.

NVIDIA Video Driver Controls E - 15

4

Function Key
Combination

You can use the Fn + F7
key combination to tog-
gle through some dis-
play options:

» Notebook Only

« External Display Only

» Notebook + External
Display

Make sure you give the
displays enough time to
refresh.

Figure E - 10
Set Up Multiple
Displays




To Enable Extended Desktop (Windows Display Properties)

1.
2.

3.
4,
5

Attach your external monitor to the external monitor port, and turn it on.

Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View
choose Appearance and Themes).

Double-click Display (icon).

In the Display Properties dialog box, click Settings (tab).

Click the monitor icon (e.g. B), and make sure you have checked “Extend my Windows desktop onto this
monitor.” and click Apply.

Display Properties @ Click the appropriate mon- y
Themes | Desktop | Screen Saver | Appearance ISetlimgs | itor iC0n (e-g- ) tO be able
Drag the marnitar icans ta match the physical arangement of your monitars. g = to Select the Op“on to ex- D|Sp|ay Sett“’]gs EXtended
tend the desktop on to it. Desktop
. . Use the control panel to drag the mon-
In this example the Primary itors to match the physical arrange-
R monitor | is on the left, the ment you wish to use.
sl secondary display B is on
[ 2 Plug and Play Moritar on NVIDI& GeForee 3300M G5 v i You can drag anv icons or windows
Sereen resolution LColor quality the rlght. u g y ! w W

across to either display desktop,

Less

J— Mare  [ihest (32 b v|
1EDI]hy12I]I]p|xe\s [l e e |

which makes it possible to have one
program visible in one of the displays,
and a different program visible in the
other display.

Extend my \N"lndnws desktnp onta this manitar

[ dentify ”Iroubleshuot.. ] [ Advanced ]

[ QK l[ Cancel ][ Lpply l

Figure E - 11 - Display Properties (Extended Desktop)
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Power Management Features

To conserve power, especially when using the battery, your computer uses the ACPI
power management system. Power management conserves power by controlling in-
dividual components of the computer (the monitor and hard disk drive) or the whole
system.

The Power Options control panel icon in Windows (see page E - 3) allows you to
configure power management features for your computer. You may conserve power
through individual components such as the monitor or hard disk, or you may use ei-
ther Stand by or Hibernate mode to conserve power throughout the system.

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques
and gives the operating system (OS) direct control over the power and thermal states
of devices and processors. For example, it enables the OS to set devices into low-
power states based on user settings and information from applications. ACPI is fully
supported in Windows XP.

Power Management Features E - 17
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OS Note

Power management
functions  will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user's manual of your
operating system.

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)



The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage
the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable.
Battery life varies depending on the applications and the configuration you're using. To increase battery life,
let the battery discharge completely before recharging (see “How do | completely discharge the battery?”
on page E - 28).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery
Information” on page E - 25.
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Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

4

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s
“Power Options” control panel to set the power button to send the system into Stand by or
Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on
page E - 24 for details).

Turning On the Computer E - 19
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Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Turn Off Computer
command from the Start
menu in Windows. This
will help prevent hard
disk or system prob-
lems.



4

Resuming
Operation

Press a key on the key-
board, or move the
mouse/TouchPad to re-
sume from Monitor or
Hard Disk Stand by.

Figure E - 12
Power Schemes

Power Schemes

You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Stand by or
Hibernate modes (see “System Power Options” on page E - 22).

Power Options Properties @@

| Power Schemes | Alams | Power Meter | Advanced | Hibemate
o ® Select the power scheme with the most appropriate settings for
L this computer. Mote that changing the settings belov will modify
| the selected scheme.
Power schemes
| PortablerLaptop ~|
Hore /D ffice Desk
| Presentation
Always On
Minimal Power Management
bax Battery
When computer iz Plugged in g L Onnng R
batteries
Turn off maritar: | After 15 mirs v| | Adter & mins v_\
Turn off hard disks: P.&f‘ler‘éﬁ mins _\;i i‘.&‘ll‘el.é-r;\;ws -v_i
System standby: | &ifter 20 mirs ;l !Allel 5 ming |
System bibemates: | After 3 haurs vi | &fter 2 hours v-i
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Each Windows Power Scheme will also adjust the processor performance of your machine in order to save pow-
er. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery

power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC
power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall per-
formance of the computer in order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.

E
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Stand by/Hibernate
or Shutdown Error

The computer may stop
responding when you
put it into (or resume
from) Stand By or Hiber-
nate, or when you shut
down.

This error is caused by
power management
within  Windows XP,
when applied to a PC
Camera attached to the
internal USB hub.

Microsoft has posted a
Hotfix for this error on its
website (search for Hot-
fix KB909667).

Download and install the
Hotfix to correct this er-
ror.

System Power Options

You can use the system power options to stop the computer’s operation and restart
where you left off. This system features Stand by and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hibernate tab
in the Power Options control panel - see “Hibernate” on page E - 23).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to
press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.

You can use either method depending on your needs.

Stand by Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on
Stand by instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Stand by mode.
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Stand by

Stand by saves the least amount of power, but takes the shortest time to return to full
operation. During Stand by the hard disk is turned off, and the CPU is made to idle
at its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Stand by mode to save power.

Hibernate

Hibernate uses no power and saves all of your information on a part of the HDD be-
fore it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You can set your computer to automatically enter Hiber-
nate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The
system will resume from Hibernate mode by pressing the power button.

Power Options Properties @@
Power Schemes | Alams | Power Meter | Advanced | Hibemate
E when pour computer hibernates, it stores whatever it has in

memory an vour hard disk and then shuts dawn. ‘When wour
computer comes out of hibemation. it retums to its previous state.

Disk space far hibernation
Free disk space: BD1SME
Disk space required to hibemate: 248 MB
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System Resume

The system can resume
from Stand by mode by:

* Pressing the power
button

* Pressing the Sleep/
Resume key combi-
nation

« An incoming call
received on the
modem (if enabled)

* Network card (Wake
On LAN) activity (if
enabled)

Figure E - 13

Enable Hibernation
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Sleep Button

You may also configure
the Sleep/Resume key
combination (Fn + F4)
from the menu illustrat-
ed. In Windows this is
referred to as the Sleep
button.

Figure E - 14
Power Options
(Advanced - Power
Buttons)

Configuring the Power Button

The power button may be set to send the computer in to either Stand by or Hiber-
nate mode. In Stand by mode, the LED /() will blink green. In Hibernate mode
the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving
mode set to save power through individual components (e.g. hard disk, monitor), the

LED will remain green.

Power Options Properties ri'g Powar Dptions Proparties [ || | Power Options Prapertios
Poyeer Schemer | Alama | Power Meter | Advanced | Hibemate Powes Schemes | Al | Power Motes | Advanced | Hisemate Poms Scharied | Alains | Power Meter | Aubaried | Hibemate
2\, Select e porei-EivIND 1RGN KO M 15 Use. ® zu Select the power-sving sesngs you want 1o upe "\t‘l, Slsct the pvei-taving Seltings you rank b use.
Uphens Dprn Ogiions
(] Ay shaw st o B Lk [ g b s o o Lo [] Abvsatry shewy icon on the tnskbar
(%] Promgk for parmwond when computer sesumes from stancby ] Pocingt fot pt v whobrs Cvngibar tsumess o Bandby [%] Erosms for passwond vwhen compute peoumes fom sandy
Paveee bustona Fowet busiorn Fiwees utions
e | clome the ld of my ponable compuier ‘When | close the ki of sy potable computer it | clove the i of my portabile computes
Stand by - Stard by - Sharef by v
Whgn | prmez Hn paowoms Endlion on ey coemgudm Etand by ‘Wihgn | et the noweer buion on ry compules
Sbad o . Shut downy e Skt down v
D rotirg
ok e whiat 8 4o ihen | precs the slean Bution on my compules Wik | g e shors Eadion e oy cxmgdms
ﬁﬁ& Stand by - Snand by >
O et
Fuak e st 1 o
[ S1and by
N - Hibemate
Caee ] [ ot J[ Coeel ]

E - 24 Configuring the Power Button

(Sleep) Button




Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page E - 28 for instructions on how to do this).

Battery Life

Your computer’s battery life is dependent upon many factors, including the programs
you are running, and peripheral devices attached. Power Options (you may set low
battery Alarms and actions, and check the Power Meter from the Power Options
control panel), and settings in the OS will help prolong the battery life if configured
appropriately.

Pawer Optians Properties
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Powes Sichmenms | s Poves Meter | Ackvarcnd | Hibmenate,
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Tolal battery poer iemaning.  15%
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)

[mw ] Helificahion: Sourd, Test "

Aichor St by

R Progam  Nore m{
Crbcal bationy slam
= aten -
o 100
[Nam\Mm ] Holification Stnred, Test
_________ e e
AunProgram  Merne Chch, an rafrvadual bialiery icon i more ndomation.
T oK Corcal |

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure E - 15
Power Options
(Alarm & Power

Meter)
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Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you need to remove the battery for any reason,
see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 11 for information on the battery charge status, and to “Battery Information™ on page E - 25
for more information on how to maintain and properly recharge the battery pack.)

4

Conserving Battery Power

To conserve battery power:

Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by
the AC/DC adapter.

Close modem or communication applications when they are not being used.
Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the system enters sleep mode).

Disconnect any unnecessary external devices.
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Proper handling of the Battery Pack

* DO NOT disassemble the battery pack under any circumstances

» DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

SN
A&

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

=
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Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer by yourself even when you see a message that indicates the bat-
tery is critically low, just let the computer use up all of the battery power and shut
down on its own. Disable the Power Options functions in the Control Panel, espe-
cially any Alarms (unclick the tickboxes - see page E - 25) and Schemes (change
all the settings to Never - see page E - 20). As the battery nears the end of its life save
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual
disc, click Install Drivers/Option Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu. Follow the instructions to install the
driver. Alternatively click Start, navigate (Browse..) to
the executable file and then follow the manual setup in-
structions.

Figure 6 - Drivers Installer Screen 1

Check the driver installation order from Table E - 5 (the
drivers must be installed in this order) which is the
same as that listed in the Drivers Installer menu
below.

Click to select the driver you wish to install, after
installing each driver it will become greyed out (if you
need to reinstall any driver, click the Unlock button).
Follow the instructions for each individual driver
installation procedure as listed on the following pages.

Please follow steps from top to bottom in order to install drivers.

Figure 7 - Drivers Installer Screen 2
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WinXP SP2 Driver Page #
Video Page E - 31
Audio Page E - 32
Modem Page E - 32
LAN Page E - 32
TouchPad Page E - 32
CardReader Page E - 32
Hot Key Page E - 32
PC Camera Module Page E - 39
WLAN Module Page E - 45
3.5G Module Page E - 47
Fingerprint Reader Module Page E - 48

Table E - 5 - Driver Installation

E - 30 Driver Installation

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Add/Remove Programs item. If you see the
individual driver listed (if not see below), uninstall it,
following the on screen prompts (it may be necessary to
restart the computer). Go to the appropriate section of the
manual to complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Programs

item:

1. Click Start (menu), point to Settings and click Control
Panel (or click Start > Control Panel).

2. Double-click System (icon); System (icon) is in

Performance and Maintenance (category).

Click Hardware (tab) > Device Manager (button).

4. Double-click the device you wish to update/reinstall the
driver for (you may need to click “+").

5. Look for the Update Driver button (check the Driver
tab) and follow the on screen prompts.

w
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Windows XP Service Pack 3

Make sure you install Windows XP Service Pack 3 (or a
Windows XP version which includes Service Pack 3) be-
fore installing any drivers.

Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Video
1. Click 1.Install Video Driver > Yes.

Models A, B & E (SiS):

2. Click Next > Next > Next > Next.

3. Click Next (click Yes if you want to view the
ReadMe file).

4. Click Finish to restart the computer.

Models C. D & F (NVIDIA):

5. Click Next.

6. Click “Yes, | want to restart my computer
now” (button).

7. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play Properties control panel to adjust the video set-
tings to the highest resolution (see “Video Features”
on page E - 7).
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Audio

1. Click 2.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.

3. The modem is ready for dial-up configuration.

4

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Modem
Options).
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LAN

1. Click 4.Install Lan Driver > Yes.

2. Click Next.

3. Click Finish > Finish to restart the computer.
4. The network settings can now be configured.

TouchPad
1. Click 5.Install Touchpad Driver > Yes.

2. Click Next > Next > Next.
3. Click Finish to restart the computer.

CardReader

1. Click 6.Install Cardreader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Hot Key

1. Click 7.Install Hotkey Driver > Yes.

2. Click Next > Install.

3. Click Finish > Finish to restart the computer.



Module Drivers Wireless LAN, Bluetooth & 3.5G Modules

See the following pages for the driver installation pro-

cedures for any of the optional modules included in ZAS
Wireless Device Operation Aboard Aircraft

your purchase configuration.
The use of any portable electronic transmission devices
aboard aircraft is usually prohibited. Make sure the module(s)
are OFF if you are using the computer aboard aircraft.

% Drivers Installer

——

4

Wireless LAN, Bluetooth & 3.5G Modules Power Toggle

Enable power to the modules as follows:

Fn + F11 = Wireless LAN Module Power Toggle

Fn + F12 = Bluetooth Module Power Toggle
Fn + [Z] = 3.5G Module Power Toggle

The LED indicator (l';ﬂ), will be green if the WLAN module is on,
and orange if the Bluetooth module is on.

Figure 8 - Option Drivers
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Bluetooth Module

The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows
XP, and therefore does not require a driver. Use the Fn + F12 key combination (see “Function Keys/Hot Key
Indicators” on page E - 5) to toggle power to the Bluetooth module.

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
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Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection RS
in the taskbar, set it up as follows: Wireless Device

Operation Aboard

1. Access the Network Connections control panel in Windows (Start > Settings > e

Network Connections OR Start > Connect To > Show all Connections) or by

clicking the taskbar icon | The use of any portable

electronic transmission de-

2. Right-click the Bluetooth connectlon icon, and select Properties. : . )
w e L vices aboard aircraft is usu-
3. Click to put a tick (if none is present) in the “Show icon in the notification area EEHFERINEETVE ST
when connected” box and click OK. the module(s) are OFF if
4. Close the control panels and the icon [ for the Bluetooth local area connection will BRI EREERIEEETES

be displayed in the taskbar when connected (see sidebar and overleaf). aboard aircraft.

Use the Fn + F12 key com-
Geeral | Advanced| bination to toggle power to

. : e = 2 v
% Network Connections [E][E]B] § 4 Local Area Connection 4 Properties
Fle FEdt biew Favorites Tools Advanced  Help [

Qo O B P e [T Eoreonig the Bluetooth module, and
ficidese @ Hetwork Connections bl ke ‘. Blustoath PAN Network Adapter ‘[m ez it LD el i
“# LAN or High-Speed Internet = . .
o anSe see if the module is pow-
ered on or not (see

Network Tasks i . ]
A s This connection uses the following ftems:
2 Local res Comection

Sl Netwark cable urplugged, Fire,.,

connection
¥I1A Rhine 11 Fast Ethernet Ad...
B e —dk = .Q Fils and Prirtsr Shating N /
affice netwark. Local Area Connection 3 ¢ = Qo5 Packet Scheduler
@ Change Windows Connected, Firewaled )
Firewall settings T, Microsoft Tyvideo Connection 1 9 Intemet Protosol (TCR/IF)
& Enable this network =
device Wireless Network Connection
il [(Tl] Realtek RTLB167 Wireless 802. .. o i
Change settings of this escription

connection Allovs your computer o access iesources on a Microsoft

T FigureE-1

Other Places el ==

B contral Parel k- Sjjt: it Show icon in notification area when connected L ocC al A rea
S My Hebwork Places Rename T BION N0 cornectivity i

)t pocments Connection

g My Computer

|
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Bluetooth Taskbar
Icon

If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth Devices
control panel. Click Op-

tions (tab), and make
sure that Show Blue-
tooth icon in the notifi-
cation area check box
has a tick inside it.

Note that you will need
to check the LED indica-
tor to see if the module
is powered on or not.

Figure E - 2
Bluetooth Devices &
Click Icon Menu

Bluetooth Configuration in Windows XP

Setup your Bluetooth Device so the Computer Can Find it

1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On

1. Pressthe Fn + F12 key combination to power on the Bluetooth module.

2. A Bluetooth icon £ will appear in the taskbar (see sidebar).

3. You can then do any of the following to access the Bluetooth Devices control
panel.

« Double-click the icon ﬂ to access the Bluetooth Devices control panel.
¢  Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Blue-
tooth Devices (Network and Internet Connections).

¢  Click/Right-click the icon ﬂ and choose an option from the menu.

Hluvetooth Devices &l

&add a Blustonth Device

Dieces. | Opsiors: | COM Posts | Hardevsrs

Show Bluetooth Devices

Phanes sl modems

;w{ﬁﬂ.

Send a File
Receive a File

Join a Personal Area Metwork
Cpen Bluetooth Settings

Remove Blustooth Icon
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To Add a Bluetooth Device

1.
2.

3.
4,
5

N o

Access the Bluetooth Devices control panel.

Click Options (tab), and make sure that Allow Bluetooth devices to connect to
this computer check box (Connections) has a tick inside it.

Click Devices (tab), and then click Add.

The Add Bluetooth Device Wizard will appear.

Click to select “My device is set up and ready to be found”, and then click Next.

Figure E - 3
P’)\‘Cll_:_onﬁto the Add Bluetooth S Mt e L rwe ool 8‘ Add Bluetooth
st i s Device Wizard
. e : Mk 530 h i -
; L3l } 6

Comgusins [work datuons, severs, Laghapa, POAL] /

O Passkey Options
T A ot Basnocth, it shal o e e e s |

) (o] =) =J You can allow the sys-
=

The Wizard will then search for any available Bluetooth devices within range. 550 1D e [ 27

Click to select the device you want to communicate with, and click Next.
Select an appropriate passkey option and click Next.

key for you. You will
then be prompted to en-
ter the generated pass-
key on your Bluetooth
device.

FigureE -4
Passkey Option
Click Finish.
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

*  Change the name of the device (click General, type a new name and click OK).
» Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices

1. Access the Bluetooth Devices control panel.

2. Click Options, and make sure that Turn discovery on check box (Discovery) has
a tick inside it.

3. Make sure that Alert me when a new Bluetooth device wants to connect check
box (Connections) has a tick inside it, if you want to be notified when a Bluetooth
device wants to connect.

F | g ure E - 5 Bluetooth Devices 3
Bluetooth Devices Davices| Options | COM Parts | Hardnare
(@] P tions D'(‘;E;I\/oev;yB\uetooth devices o find this computer, select the

following check box
[FIiTuin discovery ore

& To protect your piivacy. tum on discovery only when you
wart a Blugtonth device to find this computer

Connections

Use these seftings to contral whether a Bluetooth
device can connect to this computer

Allows Blustooth devices to gonnect to this computer

[#] Alert me when a new Blustooth device wants to connect

Show the Bluetocth icon in the potification area

Learn more about Blustooth setings, Restore Defaults

ok | [ Cancel | [ aeey ]
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PC Camera Module

Before installing the optional PC Camera module driver use the Fn + F10 key com-
bination to toggle power to the module. The PC Camera module uses the BisonCap
application to capture video files.

PC Camera Driver Installation

1.

ook wn

Make sure the module is powered on, and then insert the Device Drivers &
Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 1.PC Camera, Web cam > Yes.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Run the BisonCap application program from the BisonCam shortcut on the
desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).
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Taking Still Pictures

Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.

Double-click the camera
icon. Click Take a new
picture in the Camera
Tasks box.

P,
L@J BisoniZam, ME Pro



PC Camera Audio Setup (all camera modules)
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows.

1.

2
3
4
5.
6.
2
8
9.
1

Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-
click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
Click Advanced in the Volume > Device volume tab.

Click Options and scroll down and click Properties.

Select Realtek HD Audio input from the Mixer device menu.

Make sure the Mic Volume (check box) is checked, then click OK.

Boost the volume in the Recording section (in the Recording Control menu) as high as it will go.

Close the Recording Control window, and then click OK.

Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
0. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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BisonCap
BisonCap is a video viewer for general purpose video viewing and testing, and for
capturing video files to .avi format.

1. Runthe BisonCap application from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup (all camera modules)” on page E - 40) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the File
menu, and set the file name and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then click Open, then set the
“Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page E - 42 in
order to save file space, and help prevent system problems.
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Pre-Allocating File
Space

You may pre-allocate
the file size (File > Allo-
cate File Space) for the
capture file in the
BisonCap program.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.

See also “Reducing
Video File Size” on
page E - 42.



Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties) If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on the C: drive system partition.
In order to prevent system problems it is recommended that you save the captured video file to a location other
than the C: drive (see “Set Capture File” on page E - 41), limit the file size of the captured video (see “Pre-
Allocating File Space” on page E - 41) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Runthe BisonCap program.
2. Goto Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
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Eliminating Screen Flicker

If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Runthe BisonCap program.

2. Goto Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Properties @
Piopetty Page | Video Proc Amp | Camera Conrol |
I duto white Balance RGE gain
Environment R & I ]
& ke ™ Tungsten G i
" Daylight " Fluorescent
Riotation requency
™ Horizontal ™ Vertical " Dissble ¢ S0Hz % GOHz
™ EFFECT MODE
~EFFECT
& £
I Laow Light Mode
¢ EMBAOS ol
= SER|
Feset
Ok Cancel

Figure E - 6
Video Capture Filter
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FigureE-7
Zoom/Setting

SN
A&

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Goto Zoom and select Zoom Out/Zoom In.

m Help

oo Ok

Zoom In

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.

2. Go to Options/Capture and select Take Picture/Snapshot.

3. The picture (in JPEG format) will be placed in the Snapshot folder f=
desktop.
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WLAN Module

ML
Before installing the optional 802.11b/g USB WLAN module driver use the Fn + 'ﬁl\

F11 key combination to toggle power to the module. Wireless Device
Operation Aboard

Aircraft

802.11b/g WLAN Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

The use of any portable
electronic transmission de-

ities + User’s Manual disc into the CD/DVD drive. vices aboard aircraft is usu-
2. Click Option Drivers (button). ally prohibited. Make sure
3. Click 2.Wireless Lan > Yes. ot ot sing the computer
4. Choose the language you prefer and click Next. aboard aircraft.
5. Click Next > Install.
6. Click Finish to complete the installation. use the Pn + F11 key com-
. . . . . bination to toggle power to
7. The operating system is the default setting for Wireless LAN control in the WLAN module, and
Windows XP. check the indicator to see if
8. Access any available wireless networks from Network Connections > g‘reng:o(ggf 5 [PONTETEE €
Wireless Network Connection menu in Windows, or click the icon &g & in /

the taskbar, and click View Wireless Connections. ).
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Network
Connection

Use the Windows Net-
work Connections con-
trol panel to access
available wireless net-
works (Start > Settings >
Network Connections
or Start > Connect To >
Show all Connections).

Figure E -8
Wireless Network
Control Panels

E - 46 WLAN Module

" Network Connections

Edit

Eile

Q- ©

Yiew  Favorites

Lﬁ ):’Sear(h [ Folders

Iools Advanced  Help

Aglress | € Network Connections

Network Tasks

[E] Create anew
cannection
Set up & home or smal
office network

@ Change Windows

Firewall setings

" Wireless Network Connection Status

“ | LANor High-Speed Internet

Local Area Connection
Network cable Unplugged, Fire...
il 5 Marvel Yukon 88EB053 PCIE ..

1394 Connection
Connected, Firemalled

T A, 1594 Nk Adepter

2 Wireless Network Cannection
Comnected, Firewalled
L ) Atheras ARS004: Wireless Ne... =

Gieneral | Suppent| I Network Tasks
Conngction @ Refresh network list
Stalus Connected
Netwark: NRE3-80211a <2 Set up & wireless network
: for & homs or small oFfice
Duration ool 22
Speed: 108.0 Mbps
Related Tasks
Signal Strength aill]
\dJ Learn about wireless
netwarking
i B Change the order of
preferred networks
Sent — —  Fieceived ”
¥ Change advanced
Tt settings
Packets | 3
[Broperties J [ Dissble | [ View Wielsss Networks

!5 Wireless Network Connection :

Choose a wireless network

Click an item in the lisk below to connect to a wireless network in range or t get more
information.

NR63-802-11a Connected

NRE3-802-11g

(‘r)

Unsecured wircless netwerk. ailll




3.5G Module

If you have included an optional 3.5G module in your purchase option follow the instructions on page 7 - 18 to
install the USIM card (which will be provided by your service provider), and then install the application.

Before installing the application, make sure that the 3.5G module is on. Use the Fn + [Z] key combination (see
“Function/Hot Key Indicators” on page 1 - 15) to toggle power to the 3.5G module.

3G Watcher Application Installation

1.

PN~ WN

10.

Enable power to the module by pressing the Fn + [Z] key combination (the on screen icon , _ | will
indicate the module’s power status).

If a Found New Hardware Wizard appears, click Cancel.

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 3.3G Driver > Yes.

Click Next.

Click the button to accept the license agreement, and then click Install.

When the next screen appears wait (about 2 minutes) until the 3G Watcher application appears on
screen (as per Figure 7 - 16 on page 7 - 20) before clicking Finish (this allows the hardware to detect
the 3.5G module).

You can access the 3G Watcher application from the Start menu (Start > Programs/All Programs >
Sierra Wireless > 3G Watcher), or by clicking the desktop icon F.

See “Setting Up a Carrier Profile” on page 7 - 21 and “Connecting to the Service Provider” on
page 7 - 23 for instructions on using the 3G Watcher application.
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Help & Manual

Right-click the taskbar icon
[# to bring up the menu to
select Help.

Insert the Device Drivers &
Utilities + User's Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click
4.FingerPrint > Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User's
Manual (button), and click
Install Acrobat Reader
(button).

Fingerprint Reader Module

If you have included the fingerprint reader in your purchase option (optional for
Models C & D only) you will need to install the driver as per the instructions below.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Pro-
tector Suite QL > Fingerprint Tutorial after installing the driver.

Fingerprint Reader Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD
drive.

Click Option Drivers (button).

Click 4.FingerPrint > Yes.

Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.

See overleaf for information on enrolling fingerprints etc.

Noakwd
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User Enrollment

1.

Eal SN

©o~No v

Click Start > Programs/All Prog

icon [J£].

rams > Protector Suite QL > User Enrollment, or double click the taskbar

On the first run of the program you will be asked to click the button to accept the license, and then click OK.
Click Next and select “Enrollment to the hard disk”, and click Finish.

Click Next and you will then be prompted to enter your Windows password (note: If you have not set a
password Protector Suite QL cannot secure access to your computer).

Click Next > Next (tick the “Run interactive tutorial” tickbox to run through the Fingerprint Tutorial).

Click Next for each window of the tutorial (you can click the button to “skip tutorial” at any time).

Click the button above any of the

fingers to begin the enrollment process for that finger.

Swipe the finger three times to enroll that finger.
Repeat the process for all the fingers you wish to enroll (see below), and then click Next.

Enroliment
User's Fingers
Enrollment is the process of cre
button above a finger to enroll

ating fingerprint samples identifying the user. Click a p ; ;
the selected finger,

Fingerprint
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

e ] e

Figure E - 9 - Fingerprint Enroliment
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10. Click Finish.

11. Click any of the headings under “Learn more about:” to get more information on any topic.

12. Click Close.

13. Right-click the taskbar icon ﬁ| to bring up the menu that allows you to Edit Fingerprints, start Control Center,
access the Help menu etc. You can also run the Control Center etc. from the Protector Suite QL item in the
Programs/All Programs menu.

14. See “Help & Manual” on page E - 48 for further details.

15. If you swipe your finger over the reader at any time you can access the Biomenu to lock the computer,
register websites, open the Control Center and access the Help menu.

& Protectos Suste Seltware =TTes F

Fingerprint Control Center g mepm

(& Fingerprints i s
Enrell or edil current user's iingerprint tlemplales. @ Registered sm ’

® Settings @ -
Conligure the ingerprnt soltware. | Bt
() Help w Control Center...
Gal help informaton
< Introduction |
& Tuorial : ;
» Help [ @ Help
@ about WS =

t Elevate administrative privileges for user
Winan do | need to do this?

Figure E - 10 - Control Center & Biomenu

E - 50 Fingerprint Reader Module



	Manual
	Preface
	Chapter 1: Quick Start Guide
	Overview
	Advanced Users
	Beginners and Not-So-Advanced Users
	Warning Boxes
	Not Included
	Model Differences

	System Startup
	Operating System Setup
	System Software

	System Map: LCD Panel Open - Models A & C
	System Map: LCD Panel Open - Models B & D
	System Map: LCD Panel Open - Models E & F
	LED Indicators

	Hot Key Buttons & Keyboard
	Keyboard - Models A - D
	Keyboard - Models E & F
	Function/Hot Key Indicators
	System Map: Front & Left Views
	System Map: Right & Rear Views
	System Map: Bottom View - Models A - D
	System Map: Bottom View - Models E & F
	Windows Vista Start Menu & Control Panel
	Video Features
	Display Settings & Video Control Panel/Center

	Power Options

	Chapter 2: Features & Components
	Overview
	Hard Disk Drive
	Optical (CD/DVD) Device
	Loading Discs
	Handling CDs or DVDs
	DVD Regional Codes

	7-in-1 Card Reader
	ExpressCard Slot
	Inserting and Removing ExpressCards

	TouchPad and Buttons/Mouse
	Audio Features
	Adding a Printer
	USB Printer
	Parallel Printer


	Chapter 3: Power Management
	Overview
	The Power Sources
	AC/DC Adapter
	Battery

	Turning on the Computer
	Power Plans
	Power-Saving States
	Sleep
	Hibernate
	Shut Down

	Configuring the Power Buttons
	Resuming Operation

	Battery Information
	Battery Power
	Conserving Battery Power
	Battery Life
	New Battery
	Recharging the Battery with the AC/DC Adapter
	Proper handling of the Battery Pack
	Battery FAQ


	Chapter 4: Drivers & Utilities
	What to Install
	Module Driver Installation

	Driver Installation
	Updating/Reinstalling Individual Drivers
	User Account Control (Win Vista)
	Windows Security Message
	New Hardware Found
	Driver Installation Procedure
	Video
	Audio
	Modem
	LAN
	TouchPad
	CardReader
	Hot Key
	Optional Drivers
	PC Camera Module
	Wireless LAN Module
	3.5G Module
	Fingerprint Reader Module


	Chapter 5: BIOS Utilities
	Overview
	The Power-On Self Test (POST)
	Failing the POST
	Fatal Errors
	Non-Fatal Errors

	The Setup Program
	Entering Setup
	Setup Screens

	Main Menu
	System Time & Date (Main Menu)
	IDE Channel 0 Master (Main Menu)
	SATA Port 1/2 (Main Menu)
	System/Extended Memory (Main Menu)
	BIOS Revision/KBC/EC Firmware Revision (Main Menu)
	VGA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
	Advanced Menu
	Installed O/S (Advanced Menu)
	SATA Mode Selection (Advanced Menu)
	Legacy USB Support (Advanced Menu)
	Boot-time Diagnostic Screen (Advanced Menu)
	Power on Boot Beep (Advanced Menu)
	Battery Low Alarm Beep (Advanced Menu)
	Security Menu
	Set Supervisor Password (Security Menu)
	Set User Password (Security Menu)
	Password on boot: (Security Menu)
	Fixed disk boot sector: (Security Menu)
	Boot Menu
	Exit Menu

	Chapter 6: Upgrading The Computer
	Overview
	When Not to Upgrade

	Removing the Battery
	Upgrading the Hard Disk Drive
	Upgrading the Optical (CD/DVD) Device
	Upgrading the System Memory (RAM)
	3.5G and WLAN Module Location


	Chapter 7: Modules & Options
	Overview
	Bluetooth Module
	Bluetooth Configuration in Windows Vista

	PC Camera Module
	PC Camera Driver Installation

	Wireless LAN Module
	802.11b/g Driver Installation
	Connecting to a Wireless Network

	3.5G Module
	3G Watcher Application
	3G Watcher Application Installation
	Short Messaging Service

	Fingerprint Reader Module
	Fingerprint Reader Driver Installation
	User Enrollment


	Chapter 8: Troubleshooting
	Overview
	Basic Hints and Tips
	Backup and General Maintenance
	Viruses
	Upgrading and Adding New Hardware/Software
	Problems and Possible Solutions
	Screen Resolution Error

	Appendix A: Interface (Ports & Jacks)
	Overview
	Notebook Ports and Jacks

	Appendix B: SIS Video Driver Controls
	SIS Video Driver Installation
	Video
	Video Memory

	SIS VGA Control Center
	Display Devices & Options
	Attaching Other Displays
	To Enable a Display Setting Mode

	Appendix C: NVIDIA Video Driver Controls
	NVIDIA Video Driver Installation
	NVIDIA Control Panel
	Attaching Other Displays
	Display Modes

	Appendix D: Specifications
	Appendix E: Windows XP Information
	DVD Regional Codes
	Windows XP Start Menu & Control Panel
	TouchPad and Buttons/Mouse
	Function Keys/Hot Key Indicators
	Audio Features
	Video Features
	Display Properties & SiS Utility Manager/NVIDIA Control Panel

	SiS Video Driver Controls
	Display Devices & Modes (SiS)
	Attaching Other Displays (SiS)
	NVIDIA Video Driver Controls
	Display Devices and Modes (NVIDIA)
	Attaching Other Displays (NVIDIA)
	Power Management Features
	Advanced Configuration and Power Interface

	The Power Sources
	AC/DC Adapter
	Battery

	Turning On the Computer
	Power Schemes
	System Power Options
	Hibernate Mode vs. Shutdown
	Stand by Mode vs. Hibernate Mode

	Configuring the Power Button
	Battery Information
	Recharging the Battery with the AC/DC Adapter
	Battery FAQ

	Driver Installation
	Updating/Reinstalling Individual Drivers
	Driver Installation Procedure

	Module Drivers
	Bluetooth Module
	PC Camera Module
	WLAN Module
	3.5G Module
	Fingerprint Reader Module



